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Communications regulation information
FCC statement
This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. See instructions if interference to
radio or television reception is suspected.

Radio and television interference
The equipment described in this manual generates, uses, and can radiate radio-frequency
energy. If it is not installed and used properly—that is, in strict accordance with Apple’s
instructions—it may cause interference with radio and television reception.
This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. These specifications are designed
to provide reasonable protection against such interference in a residential installation. However,
there is no guarantee that interference will not occur in a particular installation.
You can determine whether your computer system is causing interference by turning it off. If
the interference stops, it was probably caused by the computer or one of the peripheral devices.
If your computer system does cause interference to radio or television reception, try to correct
the interference by using one or more of the following measures:
m Turn the television or radio antenna until the interference stops.
m Move the computer to one side or the other of the television or radio.
m Move the computer farther away from the television or radio.
m Plug the computer into an outlet that is on a different circuit from the television or radio.
(That is, make certain the computer and the television or radio are on circuits controlled by
different circuit breakers or fuses.)
If necessary, consult an Apple-authorized service provider or Apple. See the service and support
information that came with your Apple product. Or, consult an experienced radio/television
technician for additional suggestions. You may find the following booklet helpful: Interference
Handbook (stock number 004-000-00493-1). This booklet, prepared by the Federal
Communications Commission, is available from the U.S. Government Printing Office,
Washington, DC 20402.
IMPORTANT Changes or modifications to this product not authorized by Apple Computer, Inc.,
could void the FCC Certification and negate your authority to operate the product.

This product was tested for FCC compliance under conditions that included the use of Apple
peripheral devices and Apple shielded cables and connectors between system components. It is
important that you use Apple peripheral devices and shielded cables and connectors between
system components to reduce the possibility of causing interference to radios, television sets,
and other electronic devices. You can obtain Apple peripheral devices and the proper shielded
cables and connectors through an Apple-authorized dealer. For non-Apple peripheral devices,
contact the manufacturer or dealer for assistance.
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DOC statement
DOC Class B Compliance This digital apparatus does not exceed the Class B limits for radio
noise emissions from digital apparatus as set out in the interference-causing equipment standard
entitled “Digital Apparatus,” ICES-003 of the Department of Communications.
Observation des normes—Classe B Cet appareil numérique respecte les limites de bruits
radioélectriques applicables aux appareils numériques de Classe B prescrites dans la norme
sur le matériel brouilleur : “Appareils Numériques”, NMB-003 édictée par le ministre des
Communications.
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Follow the steps in this chapter to
set up your PowerBook Duo,
and learn about turning your
computer on and off.

1

Setting Up Your PowerBook Duo

To set up your PowerBook Duo for the first time, you need the power adapter
and the power cord that came with your PowerBook.

Step 1 Plug in the power adapter
When you plug in the power adapter, the computer’s battery recharges. You
should plug the power adapter in now in case the battery has drained during
shipping and storage.
WARNING Use only a PowerBook Duo power adapter with your
PowerBook computer. Adapters for other electronic devices (including
other portable computers) may look similar, but they may damage your
computer.

Your computer’s power adapter comes with a detached power cord.

1

1

Plug one end of the power cord into the power adapter and the other end into a threehole grounded outlet or power strip.
WARNING Your PowerBook is equipped with a three-wire grounding

plug—a plug that has a third (grounding) pin. This plug is a safety
feature, and is meant to fit only a grounded AC outlet. If you are unable
to insert the plug into an outlet, contact a licensed electrician to replace
the outlet with a properly grounded outlet.
2

Plug the power adapter cable into the power adapter port on the back panel of the
computer.

If the cable is too long, you can wind it around the hooks that open out from
the power adapter.

Power cord

Power adapter

Wrap the cable around the hooks.

Depending on where you purchased your computer, you may also have
received a wall mount plug. You can use this plug instead of the power cord to
plug the power adapter directly into an electrical outlet.

2
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Step 2 Open the display
m Slide the latch to the right and lift up the display.

Position the display at a comfortable viewing angle. You can adjust the
angle of the display at any time.

Setting Up Your PowerBook Duo
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Step 3 Turn on the computer
m Turn on the computer by pressing the Power On key above the keyboard.

Power On key

You hear a tone when you turn on the computer. It takes the computer a
moment to start up.
When you see something like this on your screen, the computer is ready to
use:

Note: Your screen should look very similar to this picture but it might not
look exactly the same.
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Problems turning on your computer?
m The computer made a sound, but you can’t see anything on the screen.

Use the brightness control buttons and contrast control buttons (if your
computer has them) to adjust the screen. (Some models have brightness
control buttons only.)

Contrast
Brightness

m Nothing happened when you pressed the Power On key.

Make sure the power adapter is firmly connected to both the computer and
a power source. If the power adapter is plugged into a power strip, make
sure the power strip is plugged in and turned on. Then try pressing the
Power On key again.
If you still get no results, press the power button on the back of the
computer.

Power button

If neither the Power On key nor the power button turns the computer on,
see Chapter 10, “Tips and Troubleshooting,” for help.

Setting Up Your PowerBook Duo
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m You see a picture of a disk with a blinking question mark on the screen.

This picture means that you need to install system software on the
computer’s hard disk. System software includes the programs the computer
uses to start itself up. You received a set of system software disks in the box
with your computer. For instructions on installing system software, see
Appendix A in this book.

What to do next
m New Macintosh users: If you have never used a Macintosh computer before,
go to Chapter 2 now to learn how to use your PowerBook. Then go to
Chapter 4 for important health and safety instructions. For help turning
your PowerBook off, or putting your PowerBook to sleep, come back to this
chapter once you have learned to use your PowerBook.
m New PowerBook users: If you have used other Macintosh computers but are
new to the PowerBook, read the rest of this chapter for instructions on
turning the PowerBook off and putting the PowerBook to sleep. Then go to
Chapter 5 to learn about using the Control Strip. Make sure you read
Chapter 4 for important health and safety instructions.
m Experienced PowerBook users: Skim this book for information about your
new PowerBook. Important health and safety instructions are in Chapter 4.
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Turning your computer off
m If the computer is on, choose Shut Down from the Special menu.

m If the computer is in sleep, wake it by pressing any key on the keyboard
(except Caps Lock), and then choose Shut Down.
m If a problem with the computer prevents you from choosing Shut Down, press
the power button on the back of the computer. This turns off the power and
you will lose any unsaved work. Use the power button only in an
emergency.

Putting your computer to sleep
When the PowerBook is in sleep, it has a darkened screen and appears to be
off, though it is still drawing battery power at a low level. The computer is on,
but almost completely inactive. To put your PowerBook to sleep:
m If the computer is on, choose the Sleep command from the Special menu.

m You can also put the computer to sleep by closing the display.
Note: If you have a PowerBook Duo 280c, a green light flashes on the upper
right of the display when your computer is in sleep.

Setting Up Your PowerBook Duo
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Automatic sleep
If you don’t use the computer for several minutes, it goes to sleep
automatically (unless you change the sleep preferences). This conserves
battery power.
To wake the computer, press any key on the keyboard (except Caps Lock). In
a few seconds, the screen will go back to the way it looked before the
computer went to sleep.
For more information on sleep and automatic sleep, see Chapter 6.

Restarting a computer that’s already on
You need to restart your computer—turn it off and back on again
immediately—when you want to make certain changes to your control panels,
use a newly installed system software file, or start up the computer from a
different disk. You also need to restart if you see a “system error” message on
the screen (indicating a temporary software problem). In this case, use the
trackball to click the Restart button that appears.
To restart your computer:
m Choose Restart from the Special menu.

When you choose Restart, the computer prompts you to save your work,
closes all open programs, and restarts itself.
Choosing Restart does not affect your RAM disk (if you created one) or its
contents.
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Go through the exercises in this
chapter to learn how to use
your computer

2

Learning to Use Your Computer

Your computer comes with a tutorial that teaches you the basics. The tutorial
is divided into two parts:
m Part 1 You start the Macintosh Basics tour on your computer, which presents
the basic skills you need to master.
m Part 2 After you complete the Macintosh Basics tour, you return to this
chapter to practice what you learned. You also learn some additional skills.
If you’ve never used a Macintosh computer before, you should complete both
parts of the tutorial.
If you are an experienced Macintosh user, you may want to look over the rest
of this book to learn about special features of this computer. Then, as you
work with your Macintosh, consult the Macintosh Reference book for answers
to questions about the system software that came with your computer.
IMPORTANT If you need to turn off your computer at any point before

finishing the tutorial, please see “Turning Your Computer Off” in Chapter 1.
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Part 1 Starting the Macintosh Basics tour
Your Macintosh Basics tour is on the hard disk that’s inside your computer. To
take the tour, follow the steps in this section.
Make sure your computer is turned on. If the screen is dark, try adjusting the
screen (see “Problems Turning On Your Computer?” in Chapter 1) until you
see words and small pictures on your screen.
1

Roll the trackball to move the arrow pointer (8) around on the screen.

Place your index finger on the trackball and your thumb on the lower
trackball button. Don’t press either button yet.
Roll the trackball, watching the arrow on the screen. Notice that the arrow
moves in the same direction as you roll the trackball.
You may need to roll the trackball around for a few seconds to “break in” the
mechanism so it works smoothly.
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2

Notice the Control Strip at the bottom of your screen.

The Control Strip

The Control Strip is the line of pictures at the lower left of your screen. You’ll
learn more about the Control Strip in Chapter 5.
3

Roll the trackball so that the tip of the arrow is on the tab at the right end of the Control
Strip.

4

Being careful not to move the trackball, press the button once.

The Control Strip closes and only the tab appears in the lower-left corner of
the screen.

Learning to Use Your Computer
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5

Roll the trackball so that the tip of the arrow is on the picture labeled “Macintosh HD.”

Make sure the tip of the arrow is over the picture, not over the words
“Macintosh HD.”
Note: Your screen should look similar to the one below, but may not look
exactly the same.
Move the arrow so that it
is on top of this picture.

Different name? The picture on your screen may be labeled “PowerBook
HD” instead of “Macintosh HD.” The different name is not important; you
can still follow directions in this manual by replacing references to
“Macintosh HD” with “PowerBook HD.”
6

Being careful not to roll the trackball, press the button twice in quick succession. (This is
called “double-clicking.”)

Now your screen should look like the illustration following step 7. The items
in that illustration may not exactly match those on your screen. The only item
you need right now is the Macintosh Basics folder.
If the screen doesn’t look right, try steps 5 and 6 again, paying special
attention to the following:
m Make sure the tip of the arrow is touching the picture, not the words
beneath it.
m Be sure to press the trackball button twice.
m Press twice quickly and be careful not to roll the trackball while you press.
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7

Move the arrow
so that it is on
top of this picture.

8

Roll the trackball to place the tip of the arrow on the picture of the folder labeled
“Macintosh Basics.”

You may see other items on
the screen. Your screen
should look similar, but may
not look exactly the same.

Being careful not to roll the trackball, press the button twice in quick succession.

Now your screen should look like the following illustration:

Learning to Use Your Computer

13

9

Roll the trackball so that the arrow is on the picture of the man labeled
“Macintosh Basics.”

Move the arrow so that it
is on top of this picture.

10

Press the trackball button twice in quick succession.

Now your screen should look like the following picture:

If you don’t see this screen, try again, paying special attention to the
following:
m Make sure the tip of the arrow is touching the picture, not the words
beneath it.
m Be sure to press the trackball button twice.
m Press twice quickly and be careful not to roll the trackball while you press.
11

Follow the instructions on the screen and work through the tour.

When you finish the tour, continue with the rest of this chapter.
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Part 2 Practicing your new skills
You should now have completed the Macintosh Basics tour.
The second part of your training gives you an opportunity to think about
what you’ve learned so far and to practice your new skills.

Reviewing what you’ve learned
Before continuing, take a few moments to answer these questions. They will
help you summarize the information you learned in Macintosh Basics. You
may want to write (or circle) your answers as appropriate. The correct
answers are in the next section of this chapter.
If you have any trouble answering the questions, look in Chapter 3, “Basic
Skills.”
Question: What is the name of the area where you do all your work? (It’s shown

below.)
Answer:____________________________________________

Learning to Use Your Computer
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Question: What are pictures on the Macintosh desktop called? Two examples are

shown below.
Answer:____________________________________________

What is the name for these
pictures on the Macintosh
desktop?

Circle the hard disk window in the illustration below.
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Circle the hard disk icon in the illustration below.

Question: Circle the active window on the desktop below. How do you make a

window active?
Answer:____________________________________________

Learning to Use Your Computer
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Question: Which menu is the Save command in?
Answer:____________________________________________
Question: How do you throw an item away?
Answer:____________________________________________
Label the parts of this window.
A.

B.
C.
D.
E.
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Answers to the review questions
These are the answers to the review questions that you completed earlier.
Question: What is the area called where you do all your work?
Answer: the desktop
Question: What are pictures called on the Macintosh desktop?
Answer: icons
Circle the hard disk window in the illustration below.

Circle the hard disk icon in the illustration below.

Learning to Use Your Computer
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Question: Circle the active window shown on the desktop below. How do you make

a window active?
Answer: by clicking anywhere inside of it

Question: Which menu is the Save command in?
Answer: the File menu
Question: How do you throw an item away?
Answer: by dragging it to the Trash
Label the parts of this window.
A. The close box

B. The title bar
C. A scroll arrow
D. The scroll bar
E. The size box
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Practice session
Now you can practice what you learned in Macintosh Basics. You’ll be
practicing your skills using real programs that came with your computer,
rather than the sample ones in Macintosh Basics.
IMPORTANT If you get lost at any point during the practice session, or if
something unexpected happens, please turn to “Clues on Your Screen” in this
chapter. These clues will help you get back on track.

1: Creating a new document
1

Open the hard disk icon and then open the SimpleText program, as shown below.
1 Double-click the hard disk
icon to open it.

2 If a window with the name
of your hard disk doesn’t
appear, click the disk icon
again twice.
3 To open the SimpleText
program, double-click the
SimpleText icon.

When the SimpleText program
opens, a window appears with
“Untitled 1” in the title bar. This
is your blank document.

Learning to Use Your Computer
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2

Use the keyboard to type a few lines of text into the blank document.

Type text in the blank document.

It doesn’t matter what you type. If you make an error, press the Delete key to
backspace over the incorrect letters, then retype.
3

Open the File menu and choose the Save command to save your new document.

When you save a document, you are storing it on the hard disk. You need to
save every document you create. If you don’t save it, the document is lost
when you turn off the computer.

Choose Save from
the File menu.

A box like the one in the next step appears, with “Untitled 1” near the
bottom. This box lets you name and save your document.
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4

Don’t click anywhere. Just type the name “Practice File.” Then click the button labeled
Save.

Type the name of
your document to
replace “Untitled 1.”

The name you type should replace “Untitled 1” in the box. If it doesn’t, place
the pointer to the left of the U in “Untitled 1,” then press the trackball button
and drag across the word. When “Untitled 1” is highlighted (the text is
surrounded with a black box), type the new name.

Click Save to save your
Practice File on the hard disk.

After you click Save, a copy of your document is stored on the hard disk in
your computer. The new name appears in the title bar of the document.
The name of your document appears in the title bar.

Learning to Use Your Computer
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5

Open the File menu and choose Quit to quit the SimpleText program.

Choose Quit from the File
menu to quit your program.

The SimpleText program closes, along with your document.
6

Check for the file you saved in the hard disk window.

You should see the icon for the document you saved in the hard disk window.
If your Practice File icon doesn’t appear, it may be in a hidden part of the
window. You can scroll through the window to find the icon if you need to.

Here’s the new file
you just created.

If you don’t see your document,
click the arrows to scroll through
the window.

That’s the end of the first exercise. You may want to take a break before you
continue.
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2: Storing your work inside a folder
You can organize your work on the Macintosh by creating folders and storing
your documents inside of them.
1

Open the File menu and choose New Folder.

A folder icon named “untitled folder” appears in the active window on the
desktop.

A new folder icon appears
in the hard disk window.

2

Without clicking anywhere, type “My Work” to name the folder.

Notice that the words “untitled folder” are highlighted and boxed. That means
the name you type will replace these words.

The new name of your
folder appears here.

Learning to Use Your Computer
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3

Drag the Practice File into the folder named “My Work.”

Move the pointer to the Practice File. Then press and hold down the button
while you drag the Practice File to the folder named “My Work.” When the tip
of the pointer is on the folder icon and the folder becomes highlighted,
release the button.

Move the pointer to this icon. Then press
and hold down the button while you drag
this icon to the folder named “My Work.”

4

Open the folder named “My Work.”

You open a folder the same way you open any icon: double-click it, or click it
and choose Open from the File menu.
The “My Work” folder window opens, and you can see your Practice File.

You have now completed the second practice exercise. You may want to take a
break before continuing.
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3: Throwing an item away
As you work, you will want to remove items you no longer need from the
hard disk. You remove items by throwing them into the Trash. In this exercise,
you will throw the Practice File into the Trash.
1

If the Macintosh HD window is not already open, open it by double-clicking the
Macintosh HD icon.

2

If the folder named “My Work” is not already open, open it.

Note: If you can’t see the Trash icon (which should be in the lower-right
corner of your screen) move the windows so that the Trash icon is visible. To
move a window, place the pointer in the window’s title bar (the stripes at the
top of the window), and drag the window.
3

Drag the Practice File to the Trash icon.

Place the pointer on the
Practice File icon. Press and
hold down the button as you
move the pointer to the
Trash icon.
When the tip of the pointer
is on the Trash icon and
the Trash icon becomes
highlighted, release
the button.

When you place an icon in the Trash, it is not immediately removed from
your disk. The Trash icon bulges to show you that the Practice File is in the
Trash, but still on your disk.

Learning to Use Your Computer
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4

Open the Trash icon (by double-clicking it) to see your Practice File there.

Your Practice File is
still in the Trash.

5

Open the Special menu and choose Empty Trash.

A dialog box appears. The computer displays a dialog box when it asks you to
confirm an action. You must click OK or another button in the dialog box
before you can take any other action.
6

Click OK.

The Trash is emptied and the Trash icon returns to normal.
The Empty Trash command permanently removes from your disk anything
that is in the Trash. Always be sure that you know what you’re removing
before you choose Empty Trash.
Note: You can get an item back from the Trash by moving its icon back to

your disk before you choose Empty Trash from the Special menu. After you
choose Empty Trash, you can’t recover items you’ve thrown away.
You have completed all of the practice exercises. Before you continue with
your own work, you might want to skim Chapter 3, “Basic Skills,” for a
summary of basic skills that you’ll need as you work.
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What’s next?
The best way to get experience working with your computer is to begin to do
your own work. You may have already purchased application programs to
work with. You’ll need to install these on your hard disk. Be sure to read the
manuals that came with your application programs for information on how to
install them. (To install your programs, you’ll need to know how to insert a
floppy disk into the Duo Floppy Adapter. See Chapter 3, “Basic Skills,” for
instructions and Chapter 8 for information about the Duo Floppy Adapter.)

Clues on your screen
As you work, check the screen frequently for these important clues about
where you are. If you are lost or if something unexpected happens, ask
yourself these questions:

Is this the right program?
Check the menu bar. If it looks like this example, you are in the Finder. If any
of these menu names are different or missing, you are inside another program.
To get back to the Finder, click anywhere on the desktop pattern.
The Finder menu bar

Learning to Use Your Computer
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Is the correct window active?
Usually only the active window is affected when you type or use a menu. The
active window has stripes in its title bar. To make a window active, click
anywhere inside it.

Is the icon or text you want to work with selected?
Commands you choose in menus usually work only if an icon or some text is
selected. Check the item you want to work with to make sure it’s highlighted
(which means it’s selected).

Is it best to start over?
If you get stuck or lost as you practice on the computer, try one or more of
the following remedies and then start the practice session over again:
m If an unwanted or confusing window is on your screen, click the Close box
in the upper-left corner of the window to close it.
m If an unwanted window or box contains a Cancel button, click it.
m If the File menu contains the word Quit, choose it.
m If you’re really stuck, restart your computer.
To restart, click the desktop (the background pattern on your screen), and
then choose Restart from the Special menu. This turns the computer off
and then back on. When you restart a computer, problems often clear up.
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Refer to this chapter for information
on basic Macintosh skills

3

Basic Skills

This section provides information on the following basic skills:
m Working with icons
m Working with windows
m Working with documents
m Working with disks
m Organizing your desktop
m Working with menus
m Keyboard shortcuts in the Finder and in directory dialog boxes
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Working with icons
An icon is a picture that represents something else.
This icon represents
the hard disk.
These icons
represent folders,
programs, and
documents that
are stored on
the hard disk.
This icon represents
the Trash.

Selecting icons
To do this

Follow these steps

Select the icon

Click the item.

Deselect an icon

Click anywhere except the selected icon.

Select multiple icons

While holding down the Shift key, click each icon.

Deselect an icon in a
group of selected icons

While holding down the Shift key, click the icon.

Select multiple icons
1. Place the pointer at one corner of a group of icons.
that are near each other 2. Drag diagonally to select the icons, then release the
button.
Select a list or partial
list of icons
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1. Place the pointer to the left of the top icon or the bottom icon.
2. Drag up or down the list, releasing the button when the
items are selected.

Copying icons
To do this

Follow these steps

Copy an icon onto
another disk

Drag the icon to the icon of the other disk
or to an icon or window that belongs to that disk.

Copy an icon
on the same disk

1. Click the icon to select it.
2. Choose Duplicate from the File menu, or press x-D.
3. If you wish, rename the new icon and drag it to a new location.
You can also make a copy by holding down the Option key
while you drag the icon to another folder or window.

Opening icons
To do this

Follow these steps

Open an icon
(disk, folder, etc.)

1. Click the icon.
2. Choose the Open command from the File menu.
Or double-click (click twice quickly) on the icon.

Moving icons
To do this

Follow these steps

Move an icon
on a disk

Drag the item to the location you want.

Naming icons
To do this

Follow these steps

Select text in an
icon’s name

Click the icon name (not the icon itself).

Rename an icon

1. Select the text under the icon.
2. Type the new name.
3. Press the Return key.
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Removing items from the disk and retrieving them from the Trash
To do this

Follow these steps

Erase or remove
an item from a disk

1. Drag the icon to the Trash.
2. Choose Empty Trash from the Special menu.

Retrieve an item
from the Trash

1. Open the Trash icon.
2. Drag the icon out of the Trash (and into the disk or folder window
where you want to store it). Or, choose Put Away from the File menu to
return the icon to its original place on a disk.

Working with windows
A window opens when you double-click an icon. A window usually shows
you what’s inside an icon.
Click the close box to
close a window.

This is a window
showing you what’s
on the the hard
disk named
“Macintosh HD.”
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Click the zoom box
to resize a window.

Drag the size box to enlarge
or reduce the window.

Click the scroll arrows to view
contents that you cannot see.

Move the scroll box up or down
to view the contents of a window
that you can’t see. The gray in
the scroll bar indicates that there
are contents of the window that
you cannot see.

Viewing the contents of a window
To do this

Follow these steps

View the contents
of a window by name,
date, size, or kind

1. Open the View menu.
2. Choose the menu item that corresponds to the way you want to
view the contents of the window.

View the contents of
the window in outline
form

1. Choose any list view from the View menu (any view except the
icon and small icon views).
2. Click the triangle next to a folder name to display or hide the
contents of the folder.

Making a window active
To do this

Follow these steps

Make a window
active

Click anywhere inside the window or double-click its icon.

Opening higher level folders or disks
1 Hold down the x key as you press
the title of the active window.
2 Drag to choose a higher-level folder
(or disk) and then release the button.
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Working with documents
Opening and closing a document
To do this

Follow these steps

Open a document

1. Click the icon for the document.
2. Choose the Open command from the File menu.
Or double-click (click twice rapidly) on the icon.

Close a document

Choose Close from the File menu. Or click the close box of the
document window.

Opening a document from within a program
To do this

Follow these steps

Open a document
when you are working
in an open program

1. Choose Open from the File menu.
2. Click the name of the document. (The illustration
shows how to find a folder that you might not see.)
3. Click the Open button.
Press this label to open a popup menu of folders and disks.

The documents in the
disk or folder you choose
are listed here.
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Saving and naming documents
To do this

Follow these steps

Save and name a
document
for the first time

1. Choose the Save command from the File menu.
2. Type a name for the document.
3. Click the Save button.

Save the document
under another name
(Save as)

1. Choose the Save As command from the File menu.
2. Type a new name for the document.
3. Click the Save button.

Choosing a folder when saving a document
To do this

Follow these steps

Save a document while 1. Choose Save or Save As from the File menu.
working in a program
2. Click the name of the folder you want to save your document in. (The
illustration shows how to find a folder that you might not see.)
3. Click Open to open the folder.
4. Name your document.
5. Click the Save button to save the document inside the folder.
Press this label to open a
pop-up menu of folders
and disks.

The documents in the
disk or folder you choose
are listed here.
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Working with disks
You can purchase a Duo Floppy Adapter that allows you to use floppy disks
with your PowerBook Duo. See Chapter 8 for information on the Duo Floppy
Adapter.

Preparing a new floppy disk for use
See “Using Disks” in the Macintosh Reference manual.

Ejecting a floppy disk
To do this

Follow these steps

Eject a floppy disk

Drag the disk’s icon to the Trash.

Copying the contents of a disk
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To do this

Follow these steps

Copy the entire
contents of one floppy
disk onto another floppy
disk (with one disk drive)

1. Insert the original floppy disk into the floppy disk drive.
2. Drag the floppy disk icon to the hard disk icon. (The floppy disk
contents appear in a folder on the hard disk.)
3. Drag the floppy disk icon to the Trash.
4. Insert the floppy disk that you want to copy to.
5. Drag the icon of the newly created folder to the floppy disk icon.
6. Drag the floppy disk icon to the Trash.

Copy an entire
floppy disk onto a hard
disk

1. Drag the icon for the floppy disk to the icon for the hard disk.
(The floppy disk contents appear in a folder on the hard disk.)

Copy items from a
hard disk onto
a floppy disk

1. Select the items you want to copy.
2. Drag the selected icons to the floppy disk’s icon or window.

Copy items from a
floppy disk onto a
hard disk

1. Select the items you want to copy.
2. Drag the selected icons to the hard disk’s icon or window.

Erasing the contents of a disk
To do this

Follow these steps

Erase the entire
1. Insert the disk you want to erase into a disk drive.
contents of a floppy disk 2. Click the icon of the disk you want to erase.
3. Choose Erase Disk from the Special menu.
4. Respond to the messages on your screen by clicking the
appropriate buttons.

Organizing your desktop
Creating a new folder
To do this

Follow these steps

Create a new
folder

1. Choose New Folder from the File menu.
2. Type a name for the folder.
3. Press the Return key.

Placing an icon inside a folder
To do this

Follow these steps

Place an icon
inside a folder

1. Drag the icon to the folder where you want to store it.
2. Release the button when the folder icon becomes
highlighted.

Basic Skills

39

Working with pull-down menus
To choose an item from a menu:
1 Point to the menu.
2 Press to pull down the menu.
3 Drag to the item you want to choose.
4 Release the button when the
command is highlighted.

Dimmed commands
are not available.

This is the Help menu,
which you use to display
information about items on
the screen.
This is the Application menu,
which you use to see which
programs are open.

Keyboard shortcuts in the Finder and in directory dialog boxes
Key

Action

Up, Down, Left,
or Right Arrow key

Selects the next item in the direction of the arrow

Tab key
key (a, b, c...)

Selects the next item alphabetically (except in a directory dialog box
and the Chooser)

Character

Selects the first item whose name begins with that character (or the
character following closest to it in the alphabet)

x–Down Arrow

Opens the selected icon

x–Option–Down Arrow Opens the selected icon and closes the current folder
x–Up Arrow

Opens the folder that contains the current folder

x–Option–Up Arrow

Opens the folder that contains the current folder and closes the current
folder

Return or Enter

In a dialog box: the same as clicking the button with the bold outline
In the Finder: selects the selected icon’s name for editing or saves the
edited name
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Refer to this chapter for important
health-related information and
safety tips.

4

Health, Safety, and Maintenance Tips

Important care and safety instructions
For your own safety and that of your equipment, read and follow all the
instructions in this section. Keep these instructions available for reference by
you and others.

Warning
m Electrical equipment may be hazardous if misused. Operation of this
product, or similar products, must always be supervised by an adult. Do not
allow children access to the interior of any electrical product and do not
permit them to handle any cables.
m Do not use the computer in or near water.
m Do not use cables that are frayed or otherwise damaged. Hold a cable by its
connector (the plug, not the cord) when connecting or disconnecting it.
m Always handle batteries carefully.
m Do not drop, puncture, mutilate, or burn the computer or battery.
m Recharge batteries only as described in this manual and only in ventilated
areas.
m Transport batteries either inside the computer or in the protective case
provided with each battery. Do not transport unprotected batteries.
m Do not short-circuit the battery terminals (that is, do not allow a metal
object such as a paper clip or key chain to touch the terminals). Doing so
may cause an explosion or a fire.
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Caution
m If you have a problem with your computer and nothing in the computer
manuals solves the problem, take the computer to your Apple-authorized
dealer or service provider. Attempting to repair the computer yourself may
void the limited warranty.
m Do not move the computer when you can hear its hard disk spinning.
When you put the computer to sleep, wait until the screen is blank before
moving the computer.
m Use only the power adapter supplied with your computer. Adapters
designed for other electronic devices may look similar, but they may not
work with your equipment and may damage the computer.
m Never force a connector into a port. Make sure that the connector matches
the port and that it’s right side up. If the connector and port do not join
easily, they do not match.
m Do not use the computer in wet or dusty environments.
m Keep dirt and liquids away from the ports on the back panel, the keyboard,
and the trackball. If you spill any food or liquid onto the computer, shut it
down immediately and unplug it before cleaning up the spill. Depending
on what you spilled and how much got into the computer, you may have to
bring the computer to an Apple-authorized service provider for cleaning.
m Do not touch the screen with any sharp or pointed objects.
m Use only the battery supplied with your computer. Batteries designed for
other portable computers may look similar, but they may not work with
your computer and may damage it.
m When recharging the battery, use only the power adapter supplied with
your computer. Adapters designed for other electronic devices may not
work with your equipment and may damage the computer or the recharger.
m Do not leave batteries in hot locations (such as the trunk of a car).
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Important
m If the computer has been in a cold place for several hours, let it warm up to
room temperature before you use it.
m Use the computer only in environments where the temperature range is
between 50°F/10°C and 104°F/40°C.
m Do not expose the computer to very low (less than –13°F/–25°C) or very
high (more than 140°F/60°C) temperatures.
m Clean the computer’s outside surfaces with a damp (not wet) cloth. Clean
the screen with soft, lint-free paper or cloth and a mild glass cleaner. Do
not spray the glass cleaner directly onto the screen.

Caring for batteries
m Always handle batteries carefully.
m Do not short-circuit the battery terminals (that is, do not touch both
terminals with a metal object). Doing so may cause an explosion or a fire.
m Do not drop, puncture, disassemble, mutilate, or incinerate the battery.
m Recharge batteries only as described in this manual and only in ventilated
areas.
m Do not leave batteries in hot locations (such as the trunk of a car) for more
than a day or two.
m Do not leave a battery in your computer for longer than a week without
plugging in the power adapter.
m Do not leave a battery in storage for longer than 6 months without
recharging it.
m Take dead batteries to an Apple-authorized service provider for recycling or
proper disposal. The batteries contain hazardous chemicals and should not
be thrown out with household or office trash.
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Health-related information about computer use
Muscle soreness, eye fatigue, and other discomforts and injuries sometimes
associated with using computers can occur from performing any number of
activities. In fact, misuse of the same muscles during multiple activities can
create a problem that might not otherwise exist. For example, if you engage in
nonwork activities that involve repetitive stress on the wrist—such as
bicycling—and also use your computer’s keyboard improperly, you may
increase your likelihood of developing wrist problems. Some individuals are
at greater risk of developing these problems because of their health,
physiology, lifestyle, and general exposure to stress. Work organization and
conditions, such as workstation setup and lighting, also play a part in your
overall health and comfort. Preventing health problems is a multifaceted task
that requires careful attention to the way you use your body every hour of
every day.
The most common health effects associated with using a computer are
musculoskeletal discomfort and eye fatigue. We’ll discuss each area of
concern below.

Musculoskeletal discomfort
As with any activity that involves sitting for long periods of time, using a
computer can make your muscles sore and stiff. To minimize these effects, set
up your work environment carefully, using the guidelines that follow, and take
frequent breaks to rest tired muscles. To make working with your computer
more comfortable, allow enough space in your work area so that you can
change position frequently and maintain a relaxed posture.
Another type of musculoskeletal concern is repetitive stress injuries (RSIs),
also known as cumulative trauma disorders (CTDs). These problems can
occur when a certain muscle or tendon is repeatedly overused and forced into
an unnatural position. The exact causes of RSIs are not totally understood, but
in addition to awkward posture, such factors as the amount of repetition, the
force used in the activity, the individual’s physiology, workplace stress level,
and lifestyle may affect the likelihood of experiencing an RSI.
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RSIs did not suddenly arise when computers were invented; tennis elbow and
writer’s cramp, for example, are two RSIs that have been with us for a long
time. Although less common than other RSIs, one serious RSI discussed more
often today is a wrist problem called carpal tunnel syndrome, which may be
aggravated by improper use of computer keyboards. This nerve disorder
results from excessive pressure on the median nerve as it passes through the
wrist to the hand.
This section offers advice on setting up your work area to enhance your
comfort while you use your computer. Since the effects of repetitive
movements associated with using a computer can be compounded by those of
other work and leisure activities to produce or aggravate physical problems,
proper use of your computer system must be considered as just one element
of a healthy lifestyle.
No one, of course, can guarantee that you won’t have problems even when you
follow the most expert advice on using computer equipment. You should
always check with a qualified health specialist if muscle, joint, or eye
problems occur.

Eye fatigue
Eye fatigue can occur whenever the eyes are focused on a nearby object for a
long time. This problem occurs because the eye muscles must work harder to
view an object that’s closer than about 20 feet (6 meters). Improper lighting
can hasten the development of eye fatigue. Although eye fatigue is annoying,
there’s no evidence that it leads to permanent damage.
Whenever you’re engaged in an activity that involves close-up work—such as
reading a magazine, doing craft work, or using a computer—be sure to have
sufficient glare-free lighting and give your eyes frequent rest breaks by
looking up and focusing on distant objects. Remember to have your eyes
examined regularly.
To prevent discomfort and eye fatigue:
m Arrange your work space so that the furniture is properly adjusted for you
and doesn’t contribute to an awkward working posture.
m Take frequent short breaks to give your muscles and eyes a chance to rest.
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Arranging your work area and equipment
The suggestions in this section can help you work more comfortably with
your computer.
Chair
m An adjustable chair that provides firm, comfortable support is best. Adjust
the height of the chair so your thighs are horizontal and your feet flat on
the floor.
The back of the chair should support your lower back (lumbar region).
Follow the manufacturer’s instructions for adjusting the backrest to fit your
body properly.
Keyboard and trackball
m When you use the keyboard and trackball, your shoulders should be
relaxed. Your upper arm and forearm should form an approximate right
angle, with your wrist and hand in roughly a straight line.

This

Not this

m You may have to raise your chair so your forearms and hands are at the
proper angle to the keyboard. If this makes it impossible to rest your feet
flat on the floor, you can use a footrest with adjustable height and tilt to
make up for any gap between the floor and your feet. Or you may lower
the desktop to eliminate the need for a footrest. Another option is to use a
desk with a keyboard tray that’s lower than the regular work surface.
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m Use a light touch when typing or using the trackball and keep your hands
and fingers relaxed. When using the trackball or keyboard, avoid rolling
your thumbs under your palms.

This

Not this

Some computer users may develop discomfort in their hands, wrists, or
arms after intensive work without breaks. If you begin to develop chronic
pain or discomfort in your hands, wrists or arms, consult a qualified health
specialist.
m Change hand positions often to avoid fatigue.
m If you prefer, you can adjust the angle of the keyboard by lowering the legs
until they snap into position.

The back of the keyboard is slightly elevated when the legs are in use.
Otherwise, the keyboard is level.
Mouse
m If you use a mouse, position the mouse at the same height as your
keyboard. Allow adequate space to use the mouse comfortably.
Built-in display
m Adjust the angle of the display to minimize glare and reflections from
overhead lights and windows.
m If your display screen has manual brightness and contrast controls, you
may need to adjust the brightness and contrast of the screen when you take
the computer from one work location to another, or if the lighting in your
work area changes.
Health, Safety, and Maintenance Tips
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External monitor
If you use an external monitor, this suggestion may be helpful.
m If possible, arrange the monitor so the top of the screen is slightly below
your eye level when you’re sitting at the keyboard. The best distance from
your eyes to the screen is up to you, although most people seem to prefer
18 to 28 inches (45 to 70 cm).

Avoiding fatigue
m Change your seated position, stand up, or stretch whenever you start to feel
tired. Frequent short breaks are helpful in reducing fatigue.
m Allow adequate workspace so that you can work comfortably. Place papers
or other items so you can view them easily while using your computer. A
document stand may make reading papers more comfortable.
m Eye muscles must work harder to focus on nearby objects. Occasionally
focus your eyes on a distant object, and blink often while you work.
m Clean your screen regularly. Keeping the screen clean helps reduce
unwanted reflections.

What about electromagnetic emissions?
There has been recent public discussion of the possible health effects of
prolonged exposure to extremely low frequency (ELF) and very low
frequency (VLF) electromagnetic fields. Such fields are associated with
electromagnetic sources such as television sets, electrical wiring, and some
household appliances—as well as computer monitors.
Apple has reviewed scientific reports and sought the counsel of government
regulatory agencies and respected health organizations. Based on the
prevailing evidence and opinions, Apple believes that the electric and
magnetic fields produced by computer monitors do not pose a health risk.
In response to those customers who wish to reduce their exposure to
electromagnetic fields, Apple has lowered the emission levels of our products.
We are also actively encouraging further scientific research so we can
continue to promote the health and safety of our customers and employees.
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This chapter describes working with
the Control Strip, the line of
modules at the bottom of
your screen.

5

The Control Strip

What is the Control Strip?
When you first turn on your PowerBook, a line of small pictures appears in
the lower left of the screen. This is called the Control Strip. Each picture in the
Control Strip is called a module.
The Control Strip is a quick and easy way to monitor and update your
PowerBook’s power management options. For instance, you can monitor the
battery charge level and the amount of work time left on your battery. You can
also adjust such options as File Sharing and sound volume.
Scroll arrows let you view
Control Strip modules
that are not visible.

File Sharing

Power
Settings

Sound
Volume

Scroll
Arrow

Close Box
AppleTalk
Switch

Battery Monitor

HD Spin Down

Sleep
Now

Video
Mirroring

Tab

The Control Strip may look slightly different depending on the options on
your PowerBook.
To get a description of each module in the Control Strip, pull down the Help
Menu, choose Show Balloons and point to the modules one at a time.
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How does the Control Strip differ from control panels?
Many features in the Control Strip work the same way as control panels. For
the most part, however, control panels offer more options. The Control Strip
gives you an easy way to access the features you use most often. You can still
use the control panels anytime to fine-tune your settings.

Closing, opening, and resizing the Control Strip
Closing the Control Strip
The Control Strip appears on the desktop until you close it. You can close the
Control Strip one of two ways:
1 Click the tab at the end of the Control Strip.

2 Click the close box at the beginning of the Control Strip.

The Control Strip appears on top of application programs. When you close
the Control Strip, only the tab appears along the edge of the screen.

Opening the Control Strip
To open the Control Strip:
m Click once on the tab.

The Control Strip opens.
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Resizing the Control Strip
You can shorten or lengthen the Control Strip to display fewer or more
modules.
m Click and drag the tab.

The Control Strip shortens or lengthens as you drag the tab. If you shorten
the Control Strip and can no longer see all the modules, use the scroll arrows.

Hiding the Control Strip
If you want to hide the Control Strip so it does not appear at all on the
desktop:
1

Choose Control Panels from the Apple (K) menu, and open the Control Strip
control panel.

2

Click Hide Control Strip.

The Control Strip automatically disappears from the screen.
Click Show Control Strip in the Control Strip control panel when you want
the Control Strip to reappear.

The Control Strip
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Moving the Control Strip
You can drag the Control Strip to the right or left edge of your PowerBook’s
screen or any monitor your PowerBook is connected to. To reposition the
Control Strip:
1

Hold down the Option key and drag the Control Strip by its tab.

An outline of the Control Strip shows where the Control Strip will move to.
2

Release the Option key and trackball button.

The Control Strip appears in its new position, and remains there until you
move it again.

Rearranging the modules in the Control Strip
You can customize the order of the modules in the Control Strip. To rearrange
the modules:
1

Hold down the Option key and drag each module you want to move.

2

Release the Option key and trackball button.

The module you are moving snaps into place. The modules stay in the new
order until you rearrange them.

Using the Control Strip
Monitoring the charge level of the battery
Your computer draws power from a rechargeable battery. The Battery Monitor
module in the Control Strip lets you easily monitor the battery charge level.
The work time you get from your battery depends on how often you use the
hard disk, how bright the screen is, and other factors.
The Battery Monitor has four parts:
m battery icon
m battery charge level
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m battery consumption rate
m estimated work time remaining
The battery icon tells you whether a battery is
installed, is being used to power the computer,
is being recharged, or is fully charged.
If the battery is
powering the
computer, this
icon appears.

The charge level
is displayed
here.

The estimated work time remaining is
displayed here when the battery is
powering the computer.

The battery consumption rate is displayed
here when the battery is powering the
computer. Higher rates are to the right.

The battery charge level, battery consumption rate, and estimated work time
remaining change depending on the software, hardware, and power saving
features you use.
The battery icon changes depending on whether the battery is being charged,
is fully charged, or is powering the computer. Notice that the battery
consumption rate and the work time left are displayed only when the
computer is being powered by the battery.
If the power adapter is plugged in and charging
the battery, this icon appears.
The charge level changes as the battery charges.
If the power adapter is plugged in and the battery
is fully charged, this icon appears.

If the power adapter is plugged in and the battery is not
in the computer, this icon appears.

The Control Strip
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Customizing the Battery Monitor module
You can customize the Battery Monitor module to display only the features
you want. Follow these steps:
1

Click the Battery Monitor module in the Control Strip.

The following pop-up menu appears.

2

Choose the feature you want to hide or show.

You cannot hide the battery icon.

Changing the battery conservation settings
You can control your computer’s power consumption using the power
conservation settings in the Power Settings module. You can also open the
PowerBook control panel from the Power Settings module.
1

Click the Power Settings module in the Control Strip.

A pop-up menu appears.
Open the PowerBook control panel if you want
to use the Custom settings.
Better Conservation gives you longer work time.
Better Performance allows you to work with the
fewest interruptions.

2

Choose the feature you want from the pop-up menu.

The battery conservation settings shown are identical to those shown in the
Easy View area of the PowerBook control panel. For help with the
PowerBook control panel, see “Adjusting the Battery Conservation Settings”
in the “Maximizing Work Time” section of Chapter 6.
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Spinning down the hard disk
The hard disk is one of the main consumers of battery power. To extend work
time while you are using your battery, it is a good idea to turn off the hard
disk when you are not using it. This is called “spinning down” the hard disk.
To spin down the hard disk:
1

Click the HD Spin Down module in the Control Strip.

A pop-up menu appears.

2

Choose Spin Down Internal Hard Disk.

The icon shows that the hard disk is off.

The hard disk automatically turns itself back on when the computer needs it.

Putting the computer to sleep
Putting your PowerBook to sleep when you take a work break, even for a few
minutes, can give you more work time from your battery. To put your
PowerBook to sleep from the Control Strip:
1

Click the Sleep Now module in the Control Strip.

A pop-up menu appears:

2

Choose Sleep Now.

Note that if you use a PowerBook Duo 280c, a flashing green light appears in
the upper right corner of the computer’s display.

The Control Strip
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Your PowerBook goes to sleep. To wake the computer from sleep, press any
key on the keyboard (except Caps Lock). There are three other ways you put
your PowerBook to sleep:
m close the computer’s display
m choose the Sleep command from the Special menu in the Finder
m hold down the x (Command) and Shift keys while you press and release
the zero (0) key.
For more information on sleep, see Chapters 1 and 6.

Changing the file sharing options
The icon of the File Sharing module tells you whether file sharing is on and
whether users are connected.
File Sharing is turned off.

File Sharing is turned on and no users are connected.

File Sharing is turned on and at least one user is connected.

To change the file sharing option or open the File Sharing Setup control panel:
1

Click the File Sharing module in the Control Strip.

A pop-up menu appears:

2

Choose the file sharing option you want from the pop-up menu.

For more information on file sharing and working on a network, see the
Macintosh Reference book.
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Changing the sound settings
Your computer’s sound volume can be changed from the Control Strip:
1

Click the Sound Volume module in the Control Strip.

A pop-up menu appears:

2

Choose the volume setting you want from the pop-up menu.

For more information on sound, see the Macintosh Reference book.

Turning an AppleTalk connection on and off
The icon for the AppleTalk Switch module shows if AppleTalk is on or off.
AppleTalk is off.

AppleTalk is on.

Turning AppleTalk off can save you battery power. You can turn AppleTalk on
and off from the Control Strip.
1

Click the AppleTalk Switch module in the Control Strip.

A pop-up menu appears:

The Control Strip
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2

Choose the feature you want from the pop-up menu.

For more information on AppleTalk and working on a network, see the
Macintosh Reference book.

Using video mirroring
If your PowerBook is connected to an external monitor you can display the
same image on the internal display and an external monitor. This feature is
called “video mirroring.”
When an external monitor is connected to your PowerBook, the Video
Mirroring module appears in the Control Strip. The icon shows whether
video mirroring is on or off.
Video mirroring is turned off.

Video mirroring is turned on.

You can turn video mirroring on and off from the Control Strip.
1

Click the Video Mirroring module in the Control Strip.

A pop-up menu appears:

2

Choose the feature you want from the pop-up menu.

The Video Mirroring module offers exactly the same features as the
PowerBook Display control panel. For information of using the PowerBook
Display control panel, see “Using Other Equipment With Your Duo System”
in Chapter 8.
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Read this chapter to learn
how you can maximize your
PowerBook’s battery life.

6

Power Management

Power sources
Your computer can draw its operating power from two different sources:
m Main battery Your computer’s main power source is a nickel-metal-hydride
battery. The battery provides power for about 2–4 hours of work time
(depending on the battery conservation features you choose).
m AC power You can run your computer from any standard electrical outlet by
plugging in the power adapter.
Your computer also has a backup battery that maintains the contents of RAM
while you replace the main battery. The backup battery does not provide
enough power to run the computer.
These power sources are described in more detail in the following sections.

Monitoring the battery charge level
There are two ways you can monitor the charge level of your battery:
m Use the Battery Monitor module in the Control Strip. See Chapter 5 for
instructions.
m Use the Battery desk accessory. See the next section for instructions.
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Using the Battery desk accessory
The main battery provides power for about 2–4 hours of work (the exact time
depends on how often you use the hard disk, how bright the screen is, and
other factors). Use the Battery Monitor module in the Control Strip or the
Battery desk accessory to monitor the battery charge level so you can recharge
it when necessary. The Battery Monitor module is explained in Chapter 5.
To use the Battery desk accessory, follow these steps:
1

Choose Battery from the Apple menu to open the Battery desk accessory.

The Battery desk accessory appears.

The line of rectangles indicates the charge level. You can see the level
decrease while the battery is in use, and increase while the battery is
recharging in the computer.
A lightning bolt icon appears when the power adapter is plugged in and the
battery is recharging in the computer. The lightning bolt icon disappears
when the battery is fully charged.
2

If you want to put the PowerBook to sleep, click the lever to the right of the battery
gauge and then click the sleep button.
Lever
Click the Sleep button and the
PowerBook is put to sleep.

You can also put the computer to sleep by choosing the Sleep command from
the Special menu or the Sleep Now module in the Control Strip.
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Responding to low-power messages
When the battery runs low, the computer displays a series of low-power
messages. The work time remaining after you see the first message varies
depending on how you are using the computer. It’s a good idea to act
promptly.

What you should do
When you see a low-power message, you should do one of the following:
m Plug in the power adapter.
m Save your work and put the computer to sleep.

What you should know
The first low-power message is a reminder that the battery will soon run out.
When this message appears, the screen brightness dims automatically to save
power.
If you continue to work without plugging in the power adapter or changing
the battery, the computer displays a second low-power message.
The second message is followed by a third and final message indicating that
the computer is about to put itself to sleep. Within a few seconds, the
computer goes to sleep automatically to protect the contents of RAM. All
activities are interrupted. It’s a good idea to save your work when you see the
first two low-power messages to make sure you don’t lose information.
If you continue working until the computer goes to sleep automatically, you
can wake it again as soon as you plug in the power adapter or replace the
battery with a fully charged battery.
If you can’t plug in the power adapter, the contents of RAM are retained in
sleep for about a day. If you recharge or change the battery within a day, you
should be able to wake the computer and resume work where you left off.
IMPORTANT Recharge a depleted battery as soon as possible. Leaving a

depleted battery in the computer for more than several months, or in a hot
location (such as the trunk of a car) for longer than two weeks, may damage
the battery so that it can’t be recharged. If this happens, you need to replace
the battery.
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Recharging the battery
There are two ways to recharge a battery:
m Plug in the power adapter to recharge the battery without removing it from
the computer.
m Remove the battery and recharge it in the (optional) recharger.
Recharge a battery shortly before you plan to use it. The battery does not
retain its charge in long-term storage.

Recharging in the computer
Plug in the power adapter as shown.
WARNING Use only the power adapter that came with your computer.

Adapters for other electronic devices (including other portable
computers) may look similar, but they may damage your computer.

You can continue to use the computer while the battery is recharging. Using
the computer does not affect the amount of time it takes the battery to
recharge.
If you recharge a fully depleted battery with the computer in sleep or shut
down, it usually takes a little over 2 hours to bring the battery charge to
100 percent, but the time may vary depending on the PowerBook you have
and the battery you are recharging.
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Recharging in a recharger
A battery recharger and additional batteries are available for purchase. If you
purchase a recharger and an extra battery, you can charge one battery while
you use the other, so you always have a fully charged battery on hand.
The recharger can accommodate two batteries, and charges them one battery
at a time. You can put batteries in or take them out at different times.
The recharger must be plugged into an electrical outlet to charge a battery.
You can plug it in using the power adapter that came with your computer, or
you can purchase an additional (identical) power adapter from your Appleauthorized dealer.
WARNING Use only the power adapter that came with your computer
with the recharger. Using other types of power adapters may damage the
recharger, the power adapter, or both.

To recharge a battery, follow these steps:
1

Place the recharger on a level surface.

2

Connect the recharger and the power adapter as shown in the illustration.
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3

Place the battery in the recharger as shown.

Recharging begins immediately. You can remove a battery from the recharger
at any time. Remember, if you are charging two batteries, they charge one at a
time. It takes about two hours to charge each battery.
IMPORTANT To preserve a battery’s charge, don’t leave it in the recharger if the
power adapter is not plugged into an electrical outlet.

The lights on the recharger indicate the following:
m No light Either the recharger is not plugged in, the other battery is being
charged (if you have two batteries in the recharger), or the battery is
defective. (If the light goes off during recharging, there is a problem with
the battery.)
m Yellow The battery is charging.
m Green The battery is fully charged.
m Red The charge does not recognize the type of battery inserted. If you are
charging a replacement battery, follow the instructions that came with it.

Recharging in both the computer and a recharger
You can use a single power adapter to run the PowerBook Duo and the
battery recharger at the same time.

If the PowerBook is on and contains a battery that is not fully charged, the
computer charges the internal battery first. The external battery does not
begin charging until the internal battery is fully charged. If you are still using
the computer at that point, it takes a little over 2 hours for a fully depleted
external battery to charge.
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If the PowerBook is in sleep or is shut down, internal and external batteries
charge simultaneously. If both batteries are fully depleted, it takes about 41⁄2
hours to charge both. If the internal battery is fully charged or absent, the
external battery takes a little over 2 hours to charge.

Removing or replacing the battery
m If the power adapter is plugged in, you can use the computer indefinitely
without a battery.
m If the power adapter is not plugged in, the backup batteries in your computer
protect open programs and documents for about 4 minutes, allowing you
to remove the depleted battery and replace it with a charged one. (The
backup batteries maintain other kinds of information, including control
panel settings such as the clock time, for up to two weeks after the main
battery is discharged or removed.)
To remove or replace the main battery, follow these steps:
1

Save your work, and then choose Sleep from the Special menu.

You can choose Shut Down instead of Sleep if you feel more comfortable
working without the 4-minute time limit.
2

Close the display.

3

Open the battery door by pressing the small button and sliding the door in the direction
indicated by the arrow.

The door is physically attached to the battery.

4

Carefully pull the battery out of its compartment.
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5

If you are inserting another battery, slide it into the battery compartment.

Replacement batteries come with a door attached.
6

Close the battery door by pushing it back into place.
IMPORTANT Check to make sure the battery is properly inserted (the battery
should be aligned with the computer and the battery door completely closed).
If a battery is not inserted correctly, you may have performance problems.

7

If possible, plug in the power adapter in case the battery is not fully charged.
WARNING Damaged nickel-metal-hydride batteries may leak small

amounts of sodium hydroxide. This substance can cause severe burns to
the skin and eyes. If you touch a damaged battery, immediately rinse
your hands and any other affected areas with water for at least five
minutes. Do not use soap.

Disposing of dead batteries
IMPORTANT Nickel-metal-hydride batteries contain metals that can be

reclaimed and reused. Instead of throwing away dead batteries, please dispose
of them as described here.
In the United States: Return dead batteries to your Apple-authorized service
provider, who will make sure they are included in Apple’s battery recycling
program.
Elsewhere: Many countries have government- or Apple-sponsored collection
and/or recycling programs for dead batteries. Dispose of dead batteries in
accordance with the mandatory or voluntary battery collection schemes in
your country. Contact your Apple-authorized service provider for information
about the recommended battery disposal procedures in your location. If there
is no government- or Apple-sponsored return program, you can dispose of the
batteries with your regular trash, taking care not to break them open or
incinerate them.
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Replacing the backup battery
In addition to its main battery, your computer has a small backup battery that
maintains the contents of RAM while you replace the main battery.
The backup battery usually lasts for several years. You may need to have it
replaced if you notice that some of your system settings changed after you
removed or replaced the main battery. (You may notice, for example, that the
clock time is different.) By replacing the backup battery you can preserve the
contents of RAM the next time you change the main battery.
Your computer’s backup battery must be replaced by an Apple-authorized
service provider.

Reconditioning the battery
To maximize battery life, you should recondition the battery once every
30 days.

If you own a PowerBook Duo 280 or 280c
If you have a PowerBook Duo 280 or 280c, you can extend your battery’s life
by reconditioning your battery once every 30 days using the Battery
Reconditioning program, which is on the system software disk labeled Disk
Tools. You may want to keep a copy of the Battery Reconditioning program on
your hard disk so it is more convenient to use every 30 days.
IMPORTANT It takes 2 hours to run the Battery Reconditioning program and

about 2 hours to fully charge your battery in your PowerBook. During the
time you are reconditioning your battery (and recharging it if you don’t have a
recharger), you cannot use your PowerBook. Plan to recondition your battery
when you won’t need your PowerBook for at least 4 hours.
To recondition a battery, follow these steps:
1

Plug in your PowerBook using your AC power adapter.

If you have already copied the Battery Reconditioning program on your hard
disk, skip step 2 and do step 3 next.
2

Insert Disk Tools in the floppy disk drive and turn on your PowerBook.
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3

Locate the Battery Reconditioning icon and open it.

A message appears on the screen describing battery reconditioning. If you
don’t have your PowerBook plugged in, a message appears telling you to plug
it in.
4

Read the message on the screen and click OK.

The following appears:
The type of battery in your computer appears here.

The date you last
reconditioned your
battery appears here.
A warning appears
below the date if it
has been less than 30
days since the last
recondition.

5

Click Recondition if it has been more than 30 days since the last time you reconditioned
the battery.

If 30 days have not passed since the last time you reconditioned, the following
appears on the screen:

Click Quit to exit the Battery Reconditioning program.

68

Chapter 6

If 30 days have passed since you last reconditioned, this message appears:

Remember that it takes 2 hours to recondition the battery and 2 hours to fully
charge the battery. Make sure you do not need to use your PowerBook for 4
hours.
6

Click OK.

While the reconditioning cycle is taking place, the following icon appears on
the screen:

You can quit the Battery Reconditioning program at any time by pressing the
period key and the x (Command) key at the same time. Also, if you unplug
your PowerBook during reconditioning, you quit the reconditioning program.
Your battery is not reconditioned if you quit in the middle of the
reconditioning cycle.
When the reconditioning is complete, the following appears on the screen for
one minute:

7

Click OK.

The battery is reconditioned. Allow time to recharge the battery by leaving
the PowerBook plugged in for 2 hours. Follow these steps again in 30 days to
maximize the life of the battery.
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If you own a PowerBook Duo 230
If you own a PowerBook Duo 230 and want to recondition your battery, you
must fully drain and then fully recharge the battery. Follow these steps:
1

Use the computer as you normally would, but ignore the low-power messages that
appear on the screen.

Make sure to save your work when you see the low-power messages.
2

Allow the computer to go to sleep automatically after the third low-power message.

3

Recharge the battery completely before using that battery again.

See “Recharging the Battery” earlier in this chapter for help.

Maximizing work time
Your PowerBook’s battery can provide between 2 to 4 hours of work time
before you need to recharge. The actual work time available depends on what
equipment and power-saving features you’re using.

Ways to conserve battery power
Notice the battery consumption rate that is displayed in the Battery Monitor
module of the Control Strip when you are running your PowerBook off the
battery. When it points to the left, you are conserving battery power and will
have more work time from your battery. To conserve battery power, follow
these tips:
m If you’re working near an electrical outlet, plug in the power adapter.
m If you aren’t using the computer, put it to sleep and plug in the power
adapter.
m Turn down the screen brightness (¤) whenever possible. At its brightest
level, the screen consumes about a third of the power your computer is
using.
m Keep virtual memory turned off in the Memory control panel.
m If your computer has 8 MB of memory or more, you can use a RAM disk
as your startup disk to minimize hard disk use.
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m Quit any modem-related program as soon as you are finished using it. As
long as the program is open, your modem is consuming power even if you
are not using the modem.
m If you have a Duo 280 or 280c, use the Battery Reconditioning program
every 30 days.
m Keep screen dimming on in the PowerBook control panel. The lower
settings dim your screen automatically if you haven’t used the computer for
a few minutes.
m Set the Battery Conservation slider in the PowerBook control panel at
Better Conservation. The rest of this section describes these settings in
detail.

Adjusting the Battery Conservation settings
The Battery Conservation section of the PowerBook control panel gives you
several ways to control your computer’s power consumption.
The easiest approach
1

Choose Control Panels from the Apple (K) menu, and open the PowerBook control
panel. (Or use the Power Settings module in the Control Strip to open the PowerBook
control panel.)

The PowerBook control panel opens in Easy View. You can also choose
Custom View for more detailed options. See “Choosing Custom Options”
later in this chapter.
2

Drag the Battery Conservation slider to the setting you want.

Battery Conservation slider

Better Performance allows you to work with the fewest interruptions. If you
can’t plug in the computer, Better Conservation gives you more work time.

Power Management

71

3

Close the PowerBook control panel.

If you don’t use the computer for several minutes (how many depends on
which setting you choose), it goes to sleep without any action on your part.
To put the computer to sleep before automatic sleep takes effect, choose Sleep
from the Special menu or use the Sleep Now module in the Control Strip.
To wake the computer from sleep, press any key (except Caps Lock).
Automatic sleep does not take effect under the following circumstances:
m AppleTalk is turned on in the Chooser and the power adapter is plugged in.
m Your computer is connected to a shared disk on the network.
m Your computer’s serial port is in use.
m Your computer is docked in Duo Dock or Duo Dock II.
More about automatic sleep
The Battery Conservation slider controls three power conservation features:
system sleep, screen dimming, and hard disk spin down.
m System sleep is a state in which your computer uses only the power it needs
to maintain the contents of RAM (such as any open programs and
documents, and various control panel settings). If you have a PowerBook
Duo 280c, you’ll see a flashing green light above the display when the
PowerBook is in sleep.
m Screen dimming saves battery power by automatically dimming the
backlight of your PowerBook’s display screen.
m Hard disk spin down stops your computer’s internal hard disk from spinning
when it isn’t being used. If the PowerBook is in sleep, the hard disk
automatically spins down.
Notice there are five settings on the Battery Conservation slider:

The five settings in the Battery Conservation slider
indicate the time it takes for your computer to go to sleep,
the screen to dim, and the hard disk to spin down.
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The time it takes for each feature to take effect depends on the settings you
choose. If you drag the slider toward Better Conservation, it takes less time
for the system to sleep, the hard disk to spin down, and the screen to dim.
The table indicates how the battery conservation settings correspond to the
time before each power saving feature takes effect:
Minutes it takes if you choose
Conservation

Performance

System sleeps

2

3

6

8

15

Hard disk spins down

1

2

3

6

8

Screen dims

1

2

3

4

5

Choosing Custom options
For more options that affect your computer’s power consumption, slide the
switch to Custom in the PowerBook control panel.
Slide this switch to Custom view.

In Custom view, you have these
additional conservation options.
(However, reduced processor
speed is not available on the
PowerBook Duo 280 and 280c.)

Battery Conservation settings
The Battery Conservation slider works as described in the previous section. In
Custom view, you can also use three individual sliders controlling system
sleep, screen dimming, and hard disk spinning down.
As you drag the Battery Conservation slider, the three individual sliders
change. Likewise, when you drag one of the three individual sliders, the
Battery Conservation slider is affected.
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To use the sliders:
1

Choose Control Panels from the Apple (K) menu, and open the PowerBook control
panel. (Or use the Power Settings module in the Control Strip to open the PowerBook
control panel.)

2

Slide the switch to Custom.

3

Drag the sliders to choose the settings you want.

The battery conservation slider reflects the changes you make.
4

Close the PowerBook control panel.

Processor cycling
If the computer is not doing anything for a few seconds, it reduces the speed
of its microprocessor. The microprocessor comes back up to speed
instantaneously when you resume work. This feature is called processor
cycling. Processor cycling conserves battery power. Your computer
automatically comes with processor cycling turned on, and it is highly
recommended that you work with processor cycling on.
Note: Processor cycling does not occur when your PowerBook is docked in a
Duo Dock or Duo Dock II. See Chapter 8 for more information on Duo
docks.
In a few cases, processor cycling can cause programs to slow down. If a
program performs very slowly, you can turn off processor cycling temporarily.
Follow these steps.
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1

Choose Control Panels from the Apple (K) menu, and open the PowerBook control
panel. (Or use the Power Settings module in the Control Strip to open the PowerBook
control panel.)

2

Slide the switch to Custom.

3

Click the “Allow processor cycling” checkbox to remove the X.
This feature does not appear if
your have a PowerBook Duo
280 or 280c.

4

Close the PowerBook control panel.

To turn processor cycling back on, click the “Allow processor cycling”
checkbox again.
IMPORTANT To conserve battery power, turn processor cycling off only when

using programs that it interferes with. Turn processor cycling back on again as
soon as possible.
Processor speed
The reduced processor speed feature appears in the PowerBook control panel
if you have a PowerBook Duo 230. Reducing processor speed allows you to
slow the computer’s microprocessor speed (from 33 to 16 MHz). Some
programs may work more slowly, but you may gain up to 10–15 minutes of
work time before you need to recharge the battery. (The amount of time you
gain depends on how you are using the computer.)
To slow the processor speed, follow these steps.
1

Choose Control Panels from the Apple (K) menu, and open the PowerBook control
panel. (Or use the Power Settings module in the Control Strip to open the PowerBook
control panel.)

2

Slide the switch to Custom.

3

Click the “Reduce processor speed” checkbox to select it.

4

Choose Restart from the Special menu.

The computer runs at the lower microprocessor speed until you click the
“Reduce processor speed” box again to remove the check and then restart the
computer.
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Power conservation
Your PowerBook keeps track of what power source you are using and can
change the power conservation settings to maximize battery conservation and
performance for both the battery and the power adapter.
To change the power conservation settings, follow these steps:
1

Choose Control Panels from the Apple (K) menu, and open the PowerBook control
panel. (Or use the Power Settings module in the Control Strip to open the PowerBook
control panel.)

2

Slide the switch to Custom.

3

If necessary, click the Auto button to select it.

When Auto is selected, the computer will automatically use the settings you
specify in step 5 whenever the selected power source is being used. (You can
temporarily override your settings by returning to the PowerBook control
panel and selecting Manual.)
4

Choose the power source in the pop-up menu.

5

Drag the sliders to the settings you want for the selected power source.

To use the preset power conservation settings for the selected power source,
click Default. See “Adjusting the Battery Conservation Settings” earlier in this
section for more help.
6
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Close the PowerBook control panel.

Read this chapter for help using
custom options on your PowerBook
Duo and for tips on traveling and
storing your computer.

7

Customizing and Traveling With Your PowerBook

Customizing your PowerBook
There are several ways you can customize your PowerBook Duo to make your
day-to-day work easier:
m Reconnecting to shared disks If you use your PowerBook Duo on a network
to connect to shared disks, the AutoRemounter control panel lets you
reconnect automatically.
m Using a RAM disk Using a RAM disk saves you time and battery power.
When you create a RAM disk, its contents are saved in the System Folder
when you shut down your PowerBook, and then copied back to the RAM
disk the next time you turn the computer on.
m Improving the pointer display You can set options to make the pointer more
visible on the screen.
m Printing later You can set up documents to print the next time you connect
to the network printer.
These features are described in the next sections.
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Automatically reconnecting to shared disks
Your PowerBook disconnects from any shared disks it’s connected to when
you turn it off or restart it, or when it is in sleep. By using the
AutoRemounter, your PowerBook can reconnect to shared disks automatically
when you turn it back on (or wake it from sleep). In addition, if you connect a
hard disk to your PowerBook while it’s in sleep, the hard disk appears on the
desktop when you wake it up.
1

Choose Control Panels from the Apple (K) menu and open the AutoRemounter control
panel.

2

If you want to reconnect to shared disks only when you wake the computer from sleep,
click After Sleep.

If you want to reconnect when you restart the computer as well as after sleep,
click Always.

3

If you want the computer to ask for your password when you reconnect to shared disks,
click Always Entering Passwords. Otherwise click Automatically Remounting.

For better privacy and security, have your computer ask for your password
before reconnecting to shared disks.
4

78

Chapter 7

Close the AutoRemounter control panel.

Setting up a RAM Disk
Using a RAM disk saves power because it avoids using the PowerBook’s hard
disk while you are running the PowerBook from its battery. Any files that are
copied to the RAM disk are saved in the System Folder on the hard disk when
you shut down your PowerBook. The next time you start up your PowerBook,
the files are copied back to the RAM disk automatically. This feature is called
a persistent RAM disk. It allows you to use your RAM disk without having to
rebuild it every time you restart your PowerBook.
There are two ways to set up a RAM disk, depending on the amount of
memory in your computer. The first way allows you to keep application
programs and files in RAM. The second way—for maximum battery
conservation—allows you to use your RAM disk as the startup disk.
To set up a RAM disk, you need more than 4 MB of RAM in your computer.
If you have less than 8 MB of memory
If you have less than 8 MB of memory, set up a RAM disk that contains the
applications and files you use most.
1

Create a folder called “RAM Disk Backup.”

2

Put into the RAM Disk Backup folder your favorite application(s) and files you frequently
use.

Try to keep additions to this folder to a minimum.
3

Select the RAM Disk Backup folder. Then choose Get Info from the File menu in the
Finder, find the size of your RAM Disk Backup folder, and close the Get Info window.

You’ll need to remember the size of your RAM Disk Backup folder. Write it
down if you need to.
4

Choose Control Panels from the Apple (K) menu and open the Memory control panel.
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The Memory control panel appears.

5

Click the On button under RAM Disk.

6

Drag the slider to set the percentage of memory to use for the RAM disk.

Adjust the size to fit the contents of your RAM Disk Backup folder. Make
sure you allocate enough RAM to fit the size of your folder, or you will have
to repeat this step.
7

Close the Memory control panel and restart your PowerBook.

A RAM Disk icon appears on your desktop.
8

Copy the contents of your RAM Disk Backup folder to your RAM disk.

9

See “Using the RAM Disk” later in this section.
IMPORTANT When you need to turn off the computer, make sure you choose
Shut Down from the Special menu. If you use the power switch to turn off
your computer, you will lose the contents of the RAM disk.
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If you have at least 8 MB of memory
If your PowerBook has 8 MB of memory or more, you can set up a RAM disk
that contains the files needed to start up your PowerBook. This provides
maximum battery conservation.
1

Select the System Folder on your hard disk and choose Duplicate from the File menu

This creates a folder called “System Folder copy.”
2

Remove any extra extensions, fonts, and control panels you don’t use.

Make sure not to delete the files called Finder and System from the System
Folder copy, or the file called Assistant Toolbox from the Extensions folder in
the System Folder.
3

Create a folder called “RAM Disk Backup.”

4

Put the System Folder copy, your favorite application program or programs, and files
you frequently use into the RAM Disk Backup folder.

Try to keep additions to this folder to a minimum.
5

Select the RAM Disk Backup folder. Then choose Get Info from the File menu in the
Finder, find the size of your RAM Disk Backup folder, and close the Get Info window.

6

Choose Control Panels from the Apple (K) menu and open the Memory control panel.
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The Memory control panel appears.

7

Click the On button under RAM Disk.

8

Drag the slider to set the percentage of memory to use for the RAM disk.

As you drag the slider, the number in the RAM Disk Size box changes. Make
sure that the number (the amount of memory) is larger than the size of your
RAM Disk Backup folder.
9

Close the Memory control panel and restart your computer.

A RAM Disk icon appears on your desktop.
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10

Copy the contents of your RAM Disk Backup folder to your RAM disk.

11

Choose Control Panels from the Apple (K) menu and open the Startup Disk control
panel.

12

Select your RAM disk in the Startup Disk window and close the Startup Disk control
panel.

13

Choose Restart from the Special menu.

14

See “Using the RAM Disk” (the following section).
IMPORTANT When you need to turn off the computer, make sure you choose

Shut Down from the Special menu. If you use the power switch to turn off
your computer, you will lose the contents of the RAM disk.
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Using the RAM Disk
1

Start up the application programs and files on the RAM Disk while your PowerBook is
plugged into the power adapter.

Using the power adapter saves your battery.
2

Put your PowerBook to sleep.

3

Unplug the power adapter.

Your documents will be loaded into RAM when your PowerBook comes out
of Sleep.
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4

While you are running your PowerBook off the battery, try to avoid using any files that
are not on the RAM Disk.

5

When you save new files, save them to the RAM Disk.

Improving pointer display
You may notice that the pointer sometimes disappears from your PowerBook’s
screen when you move the pointer quickly. You can set your trackball (or
external mouse) to have “tracks” so you can always see the pointer on the
screen. You do this in the Mouse control panel.
1

Choose Control Panels from the Apple (K) menu and open the Mouse control panel.

The following control panel appears:

2

Click the mouse tracks length you want.

3

To display a thicker I-beam on your PowerBook, click the checkbox labeled “Thick Ibeam.”

This makes the I-beam more visible.
4

Close the Mouse control panel.
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Printing later
If you use a PostScript™ laser printer (such as a Laserwriter Pro 600) on a
network, you can set up documents to print the next time you connect to the
network printer.
1

Choose Print in the application program you are using.

Click Print in the dialog box.
The following dialog box appears:

2

Click Print Later.

The next time you connect to an AppleTalk network, this document is
printed.
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Traveling with the PowerBook
The safety instructions in the first part of this book also apply when you are
traveling. In addition, note these precautions:
m Do not transport your PowerBook while it is turned on. Put your computer
to sleep or shut it down before you move it.
m Transport batteries either inside the computer or in the protective case
provided. Do not transport unprotected batteries.
m Do not check your computer as baggage. Carry it with you.
m Have security officials manually inspect your computer and disks if you do
not want to pass them through X-ray machines.
m Be prepared to show security officials that your computer is working. Have
a charged battery or a power adapter ready to use.
m Some airlines may restrict or prohibit the use of computers in flight. Check
ahead to find out what restrictions, if any, apply.
m Take the necessary plug adapters if you’re traveling overseas. (You may
need to use them with the power adapter.) You do not need a voltage
transformer. The power adapter can handle 90 volts to 260 volts AC
(48 Hz to 62 Hz).
Check the diagrams below to determine which plug adapters you’ll need, or
ask your travel agent.
Outlet Type

Locations

United States, Canada, parts of Latin America, Japan, Korea,
the Philippines, Taiwan
The former Soviet Union, most of Europe, parts of Latin America, the
Middle East, parts of Africa, Hong Kong, India, most of South Asia
Mexico, United Kingdom, Ireland, Malaysia, Singapore, parts of Africa
China, Australia, New Zealand
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Storing the PowerBook
1

Save your work on a hard disk or floppy disks.

2

Choose Shut Down from the Special menu.

3

Close the display.

4

Recharge the battery.

Be sure your battery is fully charged if you are taking the computer places
where you cannot plug it in.
5

Store the computer in a cool, dry place.

Storage temperatures should remain between 10°C and 40°C (between 50°F
and 104°F). Avoid leaving the computer where temperatures may be extreme
or unpredictable—in the trunk of a car, for example.

Service and support
If your computer is malfunctioning but does not appear to be physically
damaged, shut it down (and leave the power adapter plugged in, if possible)
until you can get help.
If you know or suspect that your computer is physically damaged, disconnect
the power adapter, remove the battery, and do not use the computer until it
can be repaired.
See the service and support information that came with your computer for
numbers to call for assistance.
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This chapter describes the options
available for expanding your
PowerBook Duo.

8

Building a PowerBook Duo System

You can expand your PowerBook Duo to give you more power and work
options with accessories such as:
m the PowerBook Duo Dock and Duo Dock II
m the PowerBook Duo MiniDock
m the PowerBook Duo Floppy Adapter
A brief overview of these accessories is in this chapter. Instructions for using
them comes with each product. You can purchase any of these products from
an Apple-authorized dealer.

The PowerBook Duo Dock and Duo Dock II
The PowerBook Duo Dock and Duo Dock II are the most versatile expansion
options for the PowerBook Duo. A dock itself is not a computer—you need a
PowerBook Duo to use it. When a PowerBook Duo is “docked” by inserting
it into a Duo Dock, Duo Dock II or Duo MiniDock, you can have the video,
storage, and input/output capabilities available on most desktop Macintosh
computers.
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The drawing below shows one of many possible PowerBook Duo systems.

Duo Dock
PowerBook Duo, inserted into the dock

The Duo Dock and Duo Dock II come with many built-in features; several
optional features are also available. These features include:
m an internal 1.4 MB floppy disk drive
m an optional internal SCSI hard disk drive (any available capacity that meets
Apple’s specifications; up to 1 inch high)
m standard ports including SCSI (with an HDI-30 connector), monitor,
printer, modem, Apple Desktop Bus (ADB), sound input, and sound
output. On the Duo Dock II or upgraded Duo Dock, an EtherTalk port is
also provided.
m a separate mouse and keyboard
m slots for two NuBus cards for Ethernet, Token Ring, additional video, or
other capabilities. (Note that if you use two NuBus cards in your Duo Dock
or Duo Dock II and you dock a PowerBook Duo 280 or 280c, the bottom
of your PowerBook Duo may feel warm when you eject it from the dock.
This is normal and will not harm your PowerBook Duo.)
m a math coprocessor (FPU) on the Duo Dock II or upgraded Duo Dock (a
socket for an optional math coprocessor is provided on the Duo Dock) if
you are using the dock with a PowerBook Duo 230
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m built-in video support for the following monitors:
Macintosh 12" Monochrome Display
Macintosh 12" RGB Display
AppleColor High-Resolution RGB Monitor (13")
Macintosh Color Display (14")
Apple Macintosh Portrait Display (15")
Macintosh 16" Color Display
VGA monitors (requires MAC-VGA adapter)
Super VGA (56 Hz) (requires MAC-VGA adapter)
Macintosh Two-Page Display (Duo Dock II or upgraded Duo Dock only)
Macintosh 21" Color Display (Duo Dock II or upgraded Duo Dock only)
Apple 17" Multiple Scan Display (Duo Dock II or upgraded Duo Dock only)
Apple 20" Multiple Scan Display (Duo Dock II or upgraded Duo Dock only)
m 1 MB VRAM for 16-bit color on color monitors 16" or less, 8-bit grayscale
on the Apple 15" portrait monitor and the Macintosh Two-Page Display,
and 8-bit color on color monitors 17" or greater. (The Duo Dock requires a
512K VRAM SIMM expansion card for 16-bit color.)
m an automatic insert/eject feature to ensure reliable docking
m a key-operated lock to prevent theft of the docked PowerBook Duo
m a 32K RAM cache function that automatically speeds up the performance
of a docked PowerBook Duo by as much as 20 percent (The RAM cache
function is available only with a PowerBook Duo 230 computer docked in
either a Duo Dock II or an upgraded Duo Dock.)
m a slot door that protects the interior of your Duo Dock II when your
PowerBook is not docked
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91

The PowerBook Duo MiniDock
The PowerBook Duo MiniDock allows you to connect a wide variety of
devices to the PowerBook. Like the Duo Dock, the Duo MiniDock with
peripheral devices connected to it is not a computer—you need a PowerBook
Duo to make the system work.
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The minidock attaches to the back of the PowerBook Duo and allows you to
use the following types of equipment with your computer:
m any one of these Apple monitors:
Macintosh 12" Monochrome Display
Macintosh 12" RGB Display
AppleColor High-Resolution RGB Monitor (13")
Macintosh Color Display (14")
Apple Macintosh Portrait Display (15")
Macintosh 16" Color Display
m up to three Apple Desktop Bus (ADB) input devices (such as a keyboard or
mouse)
m an external 1.4 MB floppy disk drive
m up to six SCSI devices including hard disk drives, CD-ROM drives, and
scanners
m a printer
m an external modem
m LocalTalk cables
m external microphone, headphones, or speakers
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The PowerBook Duo Floppy Adapter
The PowerBook Duo Floppy Adapter allows you to connect an external 1.4
MB floppy disk drive (HDI-20) and up to three Apple Desktop Bus (ADB)
devices—such as a keyboard or mouse—to your computer.
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Using other equipment with your Duo system
If you have a Duo system that includes a Duo Dock or a MiniDock, you can
connect other equipment such as an external modem, printer, or a SCSI
device.

Connecting a modem
Apple offers an optional, low-power, internal fax/data modem for your
computer. See the modem manual for information about this modem and how
to use it. You can connect an external modem to
m the printer/modem port on the PowerBook Duo
m the modem port on a Duo MiniDock
m the modem port on a Duo Dock
To connect an external modem to your PowerBook, follow these steps:
1

Make sure the computer is in sleep or shut down.

2

Connect the modem to a power source and to the phone line.

See the documentation that came with the modem.
3

Make sure the modem is turned off.

4

Connect the modem cable to the printer/modem port (PowerBook Duo) or the modem
port (Duo Dock or Duo MiniDock).
Printer/modem port icon

Modem port icon
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5

Turn on the modem.

6

Wake or restart the computer.

If your computer does not have an internal modem, the external modem is
ready to use.
If your computer does have an internal modem, continue with step 7.
7

Choose Control Panels from the Apple (K) menu and open the PowerBook Setup control
panel.

8

Click the Normal button.

9

Close the control panel.

The external modem is ready to use. If you have problems connecting to the
external modem after following these steps, then repeat steps 1 though 7, but
choose Compatible instead of Normal in the PowerBook Setup control panel.
When you are connected to an external modem in the Compatible mode, you
cannot use the printer/modem port on your PowerBook Duo for anything
else.
If you have both an internal and an external modem, remember to select the
modem you want to use in the PowerBook Setup control panel before
opening your telecommunications program.

Building a PowerBook Duo System

95

Connecting a printer
The printer/modem port on the PowerBook Duo, and the printer port on a
Duo Dock or a Duo MiniDock, can accept either a direct cable connection (to
a printer such as the StyleWriter) or a network cable connection (to a printer
such as the LaserWriter IINTX).
Printer port

Printer port icon

Some printers, including the Personal LaserWriter SC, are connected through
the SCSI port.
If you are connecting a serial printer (such as a LaserWriter LS or a
StyleWriter), make sure that the modem selection in the PowerBook Setup
control panel is set to Normal. See “Connecting a Modem” earlier in this
chapter.
Follow the instructions that came with your printer to connect it to your
computer.
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Connecting sound input and output devices
The Duo Dock and the Duo MiniDock have a sound input port (marked with
the icon ≈) to which you can connect a microphone to record sounds on your
computer. (Sound recording is described in the chapter on sound and color in
the Macintosh Reference book.)
WARNING Do not plug a sound output device (such as a pair of

headphones) into the sound input port. Doing so may damage your
audio equipment.
The Duo Dock and the Duo MiniDock also have a sound output port (marked
with the icon -) to which you can connect speakers, an amplifier,
headphones, or other audio output devices. The sound output port accepts a
standard stereo miniplug, like that used to connect headphones to a portable
tape player.

Adding memory to your computer
Your PowerBook computer comes with at least 4 MB of RAM. By adding
memory upgrade cards you can increase your computer’s memory. (Note that
any time you have more than 8 MB of RAM, you need to turn on 32-bit
addressing. See the section on turning on 32-bit addressing in the Macintosh
Reference book for help.) You can find out how much memory your computer
has by choosing About This Macintosh from the Finder’s Apple menu.
Apple provides memory upgrades through its authorized dealers. Memory
upgrades are also available from other vendors; ask your dealer for more
information. It is recommended that memory upgrades be installed by an
Apple-authorized dealer.
Your PowerBook computer also supports virtual memory, a feature that makes
use of hard disk space to provide additional RAM.
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Using a monitor for presentations
Once you have attached an external monitor to your PowerBook Duo
MiniDock, you can use that monitor to show whatever is displayed on your
built-in display. This “video mirroring” capability is useful when you’re
making a presentation to a group. You turn video mirroring on or off in two
places:
m the Video Mirroring module in the Control Strip (See Chapter 5 for
instructions on using the Control Strip.)
m the PowerBook Display control panel
To use the PowerBook Display control panel:
1

Choose Control Panels from the Apple (K) menu and open the PowerBook Display
control panel.

2

Click the On button under Video Mirroring.

3

To turn off video mirroring, click Off.

Note that video mirroring is not available while your PowerBook is docked in
a duo dock. This feature is available only while docked using a minidock.

Using SCSI Devices
For help with SCSI devices, see Chapter 9.
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Refer to this chapter for information
about connecting SCSI devices
and using your PowerBook Duo
as a SCSI disk.

9

Using SCSI Devices

A SCSI device is any product—including hard disk drives, CD-ROM drives,
scanners, and printers—that connects with your computer by means of a
standard electronic interface called Small Computer System Interface (SCSI).

Connecting SCSI devices
You can attach up to six SCSI devices to your computer by linking them
together in a chain that starts at your dock’s SCSI port.
There is a SCSI port on the PowerBook Duo Dock and the PowerBook Duo
MiniDock. (There is no SCSI port on the PowerBook Duo.) The SCSI port
looks like this:
SCSI port icon

SCSI port

To connect a SCSI device to the SCSI port on your PowerBook, you need an
Apple HDI-30 SCSI System Cable.
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Connecting SCSI devices to your PowerBook involves these steps:
m installing software
m setting SCSI ID numbers
m checking that the SCSI chain is properly terminated
m connecting cables
These steps are described in the following sections.

Installing software
Many SCSI devices come with software that allows your computer to
communicate with them. These programs are called drivers. (If no drivers
come with a device, then it doesn’t need any.) To install a driver, follow the
instructions that came with the device.

Setting SCSI ID numbers
Each device in a SCSI chain must have a unique ID number between 1 and 6
so the computer can identify it properly.
WARNING Using two or more devices with the same SCSI ID number

can cause your equipment to malfunction. You could lose information
as a result.
Your computer has the SCSI ID number 7, and its internal hard disk has the
number 0.
The ID numbers of Apple SCSI devices can be set as follows.
1

Make sure the SCSI device is turned off.

If the device is already part of a SCSI chain, make sure that all devices in the
chain are turned off, including the computer.
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2

Locate the ID number indicator and switch (usually on the back panel of the SCSI
device).

ID number indicator

ID number switch

3

Check the ID numbers of all the devices you want to connect.

If all the devices have unique ID numbers, you can continue with the next
section, “Checking That the SCSI Chain Is Properly Terminated.”
4

If you need to change a device’s ID number, choose an available number between 1
and 6.
IMPORTANT Hard drives installed in the Duo Dock or Duo Dock II are preset

to have a SCSI ID number of 1. SCSI devices connected to a Duo Dock or
Duo Dock II should use SCSI ID numbers 2 through 6.
5

Press the appropriate button to increase or decrease the SCSI ID number.

If your SCSI device does not have an ID number switch like the one pictured
above, consult the manual that came with your SCSI device for details.

Using SCSI Devices
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Checking that the SCSI chain is properly terminated
To ensure accurate transmission of information, a chain of SCSI devices must
have a terminator at each end. Terminators are built into some SCSI devices.

SCSI terminator

m The Duo Dock and the Duo MiniDock both have built-in terminators.
m External SCSI devices from Apple do not have built-in terminators.
m External SCSI devices from other vendors may have built-in terminators;
see the documentation that came with the device.
What these facts mean to you: You do not need to add a terminator at the
beginning of the chain. You need to make sure that the last device in the chain
has an internal or external terminator, and that no other devices have
terminators.
If you are attaching one SCSI device
Make sure that there is one of the following:
m an internal terminator in that device
m an external terminator attached to that device
If you are attaching more than one SCSI device
Make sure that both of these conditions exist:
m an internal terminator in, or an external terminator attached to, the last
device
m no other terminators (internal or external) in the chain
If you have too many devices with internal terminators, your Appleauthorized service provider can remove extra terminators.
SCSI chain configurations are shown in the illustration on the following page.
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Connecting cables
WARNING When making SCSI connections, always turn off power to all

devices in the chain. If you don’t, you could lose information and
damage your equipment.

1

Shut down your PowerBook and turn off all SCSI devices in the chain.

2

To connect the first device, use an Apple HDI-30 SCSI System Cable.

Attach the smaller end of the cable to the SCSI port (marked with the icon g)
on the Duo Dock or the Duo MiniDock, and the larger end of the cable to
either SCSI port on the device.
3

To connect the next device, use a SCSI peripheral interface cable.

The connectors on the ends of the cable are the same. Attach one connector
to the available SCSI port on the first device, and the other connector to either
SCSI port on the next device.
4

Repeat step 3 for each additional device you want to connect.

The illustration shows where to add cable terminators.
Connecting one SCSI device
Terminator

HDI-30 cable

If this SCSI device has an internal
terminator, omit this external terminator.

Connecting more than one SCSI device
If this SCSI device has an internal
terminator, omit this external terminator.

HDI-30 cable

SCSI peripheral interface cables

Using SCSI Devices
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IMPORTANT The total length of a SCSI chain should not exceed 20 feet

(6 meters). Apple SCSI cables are designed to meet this restriction. If you are
using SCSI cables from another vendor, check the length of the chain.
WARNING Once your SCSI devices are connected, always turn them on

before turning on your PowerBook. If you turn the computer on first, it
may not be able to start up, or it may not recognize the SCSI devices.

Using your PowerBook as a SCSI disk
You can purchase a cable called the Apple HDI-30 SCSI Disk Adapter which
lets you connect your PowerBook to another computer and use the
PowerBook as a hard disk. The PowerBook appears as a hard disk icon on the
screen of the other computer, and you can transfer information between the
computers by dragging files. This feature is called SCSI disk mode. The
PowerBook Duo Dock and Duo Dock II do not support SCSI disk mode.
WARNING Follow the steps for connecting and disconnecting SCSI

devices carefully to avoid loss of information and damage to your
equipment.
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Connecting your PowerBook as a SCSI disk
Before making any connections, you need to assign a SCSI ID number to the
PowerBook.
1

Choose Control Panels from the Apple (K) menu of your PowerBook computer.

2

Open the PowerBook Setup control panel.

3

In the SCSI Disk Mode section of the control panel, click the ID number you want to
assign.

If you are connecting the PowerBook to an existing SCSI chain, make sure to
give it an ID number different from those of the other devices.

4

Close the PowerBook Setup control panel.

5

Turn off the PowerBook by choosing Shut Down from the Special menu.

6

Shut down the computer you want to connect your PowerBook to, and turn off other
devices in the SCSI chain.

7

Connect the PowerBook to the other computer or to the end of the SCSI chain.
WARNING Always shut down the PowerBook before connecting or

disconnecting the SCSI disk adapter cable. Connecting the adapter cable
while the computer is turned on can damage the computer.
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8

Turn on the PowerBook by pressing the power button.

After a few seconds a SCSI icon appears on the screen, showing the ID
number you assigned in step 3.

WARNING If you do not see the SCSI icon, and the PowerBook either

starts normally or displays an error message, choose Shut Down (if you
can) and then immediately disconnect your PowerBook from the SCSI
chain. Then go back and repeat steps 6 through 8.
(If you can’t choose Shut Down, try pressing the power button. If you
cannot shut down your PowerBook, disconnect your PowerBook from
the SCSI chain or you may lose information.)

9

Turn on the other SCSI devices in the chain, if any.

10

Turn on the other computer.

The PowerBook appears as a hard disk icon on the screen of the computer
you connected it to. You can now transfer and use files as if the PowerBook
were an external disk drive.

106

Chapter 9

Simplifying the SCSI disk connection process
If you regularly plan to use your PowerBook as a SCSI disk with the same
computer, you can leave the SCSI disk adapter cable attached to the other
computer or its SCSI chain. When you want to use your PowerBook as a
SCSI disk, simply shut down all devices and connect the adapter cable to the
SCSI port on your PowerBook.
These cables can stay attached to your
desktop Macintosh or its SCSI chain.

HDI-30 SCSI disk adapter

Connect and disconnect your computer here.

WARNING Always disconnect your PowerBook from the adapter cable

when you are not using it as a SCSI disk. Your PowerBook will not
work correctly if the adapter cable remains attached.

Drawing battery power in SCSI disk mode
Your PowerBook continues to draw battery power when you use it as a SCSI
disk. Low battery power is indicated by a blinking low-power warning on the
PowerBook’s screen.

If you see this warning while using your computer as a SCSI disk, either plug
in the power adapter or quit SCSI disk mode, as described in the next section,
so you can remove the battery for recharging.
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Quitting SCSI disk mode
1

Shut down the computer your PowerBook is connected to.

2

Turn the PowerBook off by holding down the x (Command) key and power button on the
back of your PowerBook (marked with the icon I) at the same time.

3

Turn off any other SCSI devices in the chain.

4

Disconnect the PowerBook from the adapter cable.

If you plan to connect your PowerBook regularly to the same computer, you
can leave the adapter cable attached to the SCSI chain or the other computer.
See “Simplifying the SCSI Disk Connection Process,” earlier in this chapter.
IMPORTANT Do not leave the adapter cable attached to the PowerBook. If you

do, the computer will behave as though it is still in SCSI disk mode when you
try to restart.
5

If necessary, disconnect the adapter cable from the other computer or its SCSI chain.

Your equipment is now ready for normal use.
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Refer to this chapter for solutions to
some common problems.

10

Tips and Troubleshooting

This chapter describes possible causes and solutions for some common
problems you may have with your PowerBook Duo, the Duo Dock, the Duo
MiniDock, or associated equipment provided by Apple. Try the possible
solutions in the order they are listed until the problem is solved. Check
explanations and instructions in this book and in the Macintosh Reference
book for additional help.
WARNING If you have a problem with your PowerBook Duo and

nothing presented in this chapter or in the manuals that came with
your computer solves it, consult the service and support information
that came with your computer for instructions on how to contact an
Apple-authorized service provider or Apple for assistance. If you
attempt to repair the computer yourself, any damage you may cause to
the computer will not be covered by the limited warranty on your
computer. Contact an Apple-authorized dealer or service provider for
additional information about this or any other warranty question.
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The PowerBook Duo
The computer won’t start.

m The computer may be on, but the screen brightness or contrast may be
turned down. Adjust the brightness and contrast controls.
m Try holding the Power On key down for 30 seconds, or until you hear a
chime.
m The battery may be drained. Plug in the power adapter, wait 30 minutes,
and then try to turn on the computer.
m Take out the battery, unplug the power adapter, and let the computer sit for
15 minutes. Then replace the battery, plug in the power adapter and try
again.
The computer won’t restart.

Try to restart your computer using one of the following methods. Try them in
the order given.
m Press the x (Command), Control, and Power On keys at the same time.

When pressed at the same time, these keys turn the computer off and back
on. Restarting the computer this way does not affect your RAM disk (if you
created one) or its contents.
m Hold down the power button (at the back of the computer) for 5 seconds to turn the
computer off, then press the Power On key.

Turning the computer off with the power button erases the contents of a
RAM disk.
m If you have a floppy disk drive, restart from a floppy disk.

1. Insert the Disk Tools disk into the floppy disk drive.
2. Press the Power On key.
If the computer restarts from a floppy disk, there is probably a problem
with your hard disk. You may be able to fix the problem yourself (using the
Disk First Aid program or another disk repair program; see the Macintosh
Reference book for help). Or you may prefer to take the computer to your
Apple-authorized service provider.
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m If you have a PowerBook Duo MiniDock and an Apple HDI-30 SCSI Disk Adapter cable,
connect your PowerBook Duo to a desktop Macintosh and start up the PowerBook
Duo as a SCSI disk.

With your PowerBook Duo acting as a SCSI drive, you can reinstall system
software from the desktop Macintosh on to the PowerBook’s internal hard
disk.
Chapter 9 and Appendix A, respectively, contain specific instructions for
connecting your computer to a desktop Macintosh and reinstalling system
software.
The computer just stopped.

m The computer may have gone to sleep. Press any key (except Caps Lock)
or the Power On key to wake it again.
m The battery may have drained so far that the computer has put itself to
sleep to protect the contents of RAM. Plug in the power adapter and then
press the Power On key.
m The computer may have “crashed” due to temporary software problems.
Click the Restart button on the screen (if you see one) or choose Restart
from the Special menu. If these suggestions don’t work, restart the
computer using the methods described in “The computer won’t restart.”
m Interrupt the program by pressing the x (Command), Option, and Esc
(Escape) keys at the same time. Click the Force Quit button in the dialog
box that appears, and then restart the computer.
The computer exhibits odd behavior, such as many unexplained system failures.

m A common cause of unexplained problems is multiple System Folders on
your computer’s startup disk. The icon for the System Folder that the
PowerBook is using to operate looks like this:

Use the Find command in the Finder’s File menu to locate any other
System Folders, and throw them in the Trash. (If you use a RAM disk as
your startup disk, do not delete the System Folder from your RAM Disk
Backup folder.)
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m You may have a virus on your hard disk. Obtain a virus-detection program,
use it to check all your disks, and eliminate any viruses the program finds.
m You may be using a program that’s not compatible with your computer’s
system software. Check the manual that came with the program or contact
the manufacturer.
m You may have added a control panel or extension that is incompatible with
other programs you use. Restart the computer, holding the Shift key down,
until you see the message “Extensions off.” If this solves the problem,
remove any control panels or extensions you recently installed.
m You may need to reinstall system software. See Appendix A for
instructions on installing system software.

Power
The battery is draining too fast.

m Turn down the screen brightness, turn off virtual memory, move the battery
conservation slider in the PowerBook control panel to Better Conservation,
or work with the power adapter plugged in.
m Your computer supplies power to the modem whenever a communications
program is open. Quit your communications program if you aren’t using it.
m If you aren’t using network services, you can also save power by turning off
AppleTalk in the Chooser.
m Your battery may need to be reconditioned completely. See Chapter 6 for
help.
m You may not have the correct power adapter. Make sure that if you are
using a PowerBook Duo 230 or 280, you have a 25-watt adapter, and if you
are using a PowerBook Duo 280c, you have a 36-watt adapter.
m Older PowerBook batteries do not hold a charge as well as new ones do.
You may need to replace the battery.
The battery can’t be recharged.

m There may be a loose connection. Take the battery out and put it back in
the computer.
m If all connections are OK, then the battery is probably damaged or dead.
You’ll need to obtain a replacement battery from an Apple-authorized
dealer.
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m If you are recharging the battery in a recharger, you may have an older
recharger with a new battery. Check to make sure you have the correct
recharger for your type of battery.
The computer goes to sleep too often.

m Open the PowerBook control panel and slide the slider to Better
Performance.
The PowerBook won’t run off the battery or the battery won’t charge.

m Make sure your PowerBook is running system software version 7.1 or later.
You may have a new battery which requires this system software.
m There may be a loose connection. Take the battery out and put it back in
the computer.
The computer doesn’t go to sleep automatically.

m You may have dragged the slider to Never in the Custom view of the
PowerBook control panel. Drag the slider to a lower setting.
m You may be connected to a shared disk on the network. If you are not using
the information on the shared disk, disconnect from it.
m The printer/modem port may be in use. Quit your telecommunications
program or turn off background printing in the Chooser (if the documents
you’re printing can wait until later).
m When application programs are working in the background, the computer
doesn’t go to sleep. In this case, choose Sleep from the Special menu.
m The computer does not go to sleep if AppleTalk is active and the power
supply is plugged in. Turn AppleTalk off in the AppleTalk Switch module
in the Control Strip.
m The computer does not go to sleep if it is being used in a Duo Dock.
m The computer does not go to sleep if you are using it with a Duo
MiniDock and an external monitor or SCSI device is attached.
m The computer does not go to sleep if you are using it with a Duo
MiniDock and you started or restarted the computer after connecting it to
another device.
See Chapter 6 for more information about batteries and power consumption.
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The screen
The screen looks blurred or out of focus.

m The viewing angle may not be optimal. Tilt the display on its hinge until
the screen looks better.
The screen is too dark.

m When you first turn on your computer, it may take several minutes for the
screen brightness to “warm up,” especially if you’ve chosen a high setting.
m The screen brightness or contrast may not be optimal for the surrounding
lighting. Adjust the brightness or contrast setting.
m The screen dims automatically when the battery starts to run low. You may
need to recharge or replace the battery before you can turn up the
brightness.
The screen is flickering.

m This problem sometimes occurs when your screen is set to display the
maximum number of grays or colors. Try adjusting the contrast control, or
select fewer grays or colors in the Monitors control panel.
There are ghost images or black dots on the screen.

m When the computer is left on for many hours, temporary images may
appear on the screen. Put the computer to sleep. The longer the computer
was left on, the longer it will take for the images to fade, but they will
eventually disappear.
The pointer moves too fast or too slowly.

m You need to adjust the pointer’s tracking speed. Open the Mouse control
panel and choose a more comfortable setting.
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The pointer won’t move at all.

m A software problem may have caused the computer to “freeze.” Restart the
computer by pressing the power button on the back of the computer, or
pressing the Command (x), Control, and Power On keys simultaneously.
You will lose any work you have not saved.
m Interrupt the program by pressing the x (Command), Option, and Esc
(Escape) keys at the same time. Click the Force Quit button in the dialog
box that appears, and then restart the computer.
A window has disappeared.

m Another open window on the desktop may have covered the one you’re
looking for. Move, resize, close, or hide windows you aren’t using until you
see the one you want.
m Windows belonging to open but inactive programs may be hidden. Choose
Show All from the Application menu to show hidden windows and choose
the correct application program from the Application menu for the window
you want to view.
An icon is blinking in the menu bar.

m A program needs attention. For example, you may have set the Alarm
Clock to go off at a particular time, or PrintMonitor may be alerting you to
a printing problem. Make the program active by choosing the icon for the
application program in the Application menu, and take the necessary
action.
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The trackball
The trackball doesn’t work smoothly; it sticks or jumps when rolled.

m There may be dust or dirt inside the trackball mechanism. To clean the
trackball, follow these steps.
1. Remove the trackball by turning the trackball retainer ring
counterclockwise, and lifting the trackball out of its cavity.
You may need to use a pen or your fingernail to lift the trackball out.
2. Locate the small rubber rollers at the left and bottom sides of the
trackball cavity.
The rollers may look like small rings or wheels.
3. Use any reasonably clean, blunt object (your fingernail) to scrape off the
rollers. Do not use any liquid inside the computer.
4. Replace the trackball and its retainer ring.
You just cleaned the trackball, and it feels worse than before.

m This problem is related to the way the trackball is lubricated. After you use
it for a few minutes, the problem should go away.

Memory
A “not enough memory” message appears when you try to open a program.

m Quit any programs you aren’t using, then try again to open the program you
want. If that doesn’t work, restart the computer. Sometimes restarting
makes additional memory available.
m If you are using a RAM disk or a disk cache, reduce its size in the Memory
control panel and then restart the computer.
m If you consistently want to open more programs than memory allows, you
can purchase a memory expansion card from your Apple-authorized dealer.
Virtual memory is supposed to be on, but it’s off.

m If you set aside virtual memory space on the hard disk in or connected to
the Duo Dock or the Duo MiniDock, virtual memory is not available when
you use the computer away from the dock. The next time you dock, virtual
memory is turned back on automatically. You can set aside space on your
computer’s internal hard disk if you want to use virtual memory when the
computer isn’t docked.
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The Duo Dock
You can’t insert the computer into the dock.

m The dock may be locked. Turn the key to the vertical (unlocked) position
and insert the computer again.
m The door covering the dock connector in the Duo Dock II may not be
open. Open the door and insert the computer again.
m The PowerBook may not be shut down. Remove the computer, open the
display, choose Shut Down from the Special menu, and try again.
You can’t turn on the docked computer.

m Make sure all your equipment is connected properly and then press the
Power On key on your external keyboard. If nothing happens, press the
power switch on the back of the dock.
The computer is on but the monitor is blank.

m Make sure that the monitor is plugged in and that its power switch is on.
Then adjust the brightness and contrast controls as necessary.
You can’t eject the computer from the dock.

m The dock may be locked. Turn the key lock to the vertical (unlocked)
position and press the eject button again.
m Power to the dock may be interrupted. Insert the dock’s key, a small
screwdriver, or a similar object into the square hole on the side of the dock
and press gently to eject the computer. (When the dock is locked, the hole
is not available.)
See the manual that came with your Duo Dock for more information.
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The Duo MiniDock
You can’t turn on the docked computer.

m Make sure your equipment is connected properly and then press the Power
On key on any of your keyboards. If nothing happens, press the power
button on the back of the minidock.
m The computer’s battery may need to be recharged. Plug in the computer’s
power adapter and then try pressing the Power On key again.
The battery drains very quickly when you use the computer with the minidock.

m If you are using an external monitor, SCSI equipment, a printer, or an
external modem, you need to plug in the computer’s power adapter.
The menu bar appears on the PowerBook’s screen, but you want it to appear on an
external monitor.

m Make sure the external monitor is connected properly and turned on.
m Make the external monitor the main monitor by opening the Monitors
control panel, dragging the small menu bar icon from the small screen to
the large one, and restarting the computer.
See the manual that came with your Duo MiniDock for more information.
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SCSI devices
You can’t turn on the computer after connecting a SCSI device.

m SCSI devices must be turned on before the computer itself. Turn on the
SCSI device(s) first, and then turn on the computer.
The computer doesn’t recognize your SCSI devices.

m The devices may be off. Check to make sure that they are plugged in and
turned on.
m If the device is a disk drive, it may need to be initialized before you can use
it. See the instructions that came with the device.
m The software (driver) needed to run the device may not be installed in your
System Folder. See the instructions that came with the device.
m Two or more devices in the SCSI chain may have the same ID number.
Check the ID number of each device to make sure each one has its own
number between 1 and 6, and change any numbers that are not unique. (If
there is a hard disk in your Duo Dock, that disk has the ID number 1.)
m When connecting SCSI equipment, it is important to use the right cables
and the correct number and placement of cable terminators. Check the
cables and terminators in the SCSI chain and make sure that all cables are
firmly attached. The first and the last device in a SCSI chain should be
terminated.
m A PowerBook in sleep connected to a Duo MiniDock cannot recognize an
attached SCSI device. Make sure the SCSI device is turned on, and then
restart the computer.
See Chapter 9 for more information about working with SCSI devices.
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Disk drives and disks
The computer won’t start up from its hard disk, or the hard disk icon doesn’t appear on
the desktop.

m There may have been a temporary software problem. Turn off the
computer, wait at least 10 seconds, and then turn it on again.
m If the computer is in a Duo Dock, someone may have selected the dock’s
hard disk as the startup disk. You can change this setting in the Startup
Disk control panel.
m There may be a problem with the system software on the hard disk. Start
up the computer with the Disk Tools disk. If the hard disk’s icon appears,
install system software as described in Appendix A. Disk repair programs
can sometimes fix problems of this kind.
m The information on the disk drive may be damaged. Try using a disk repair
program to repair or recover the information (such as Disk First Aid or
HDSC setup on the Disk Tools disk). If this doesn’t work, you’ll need to
reinitialize the hard disk. See the Macintosh Reference book for instructions.
m There may be a mechanical problem with the disk drive. If none of the
above suggestions works, call Apple (see the service and support
information for the phone number), or take the computer to an Appleauthorized service provider.
The hard disk keeps stopping and starting again.

m The hard disk may be going to sleep to conserve power. Open the
PowerBook control panel and move the Battery Conservation slider toward
Better Performance.
The icon of a floppy disk doesn’t appear on the screen.

m There may be a problem with the disk or disk drive. Try inserting a
different disk. If its icon does appear, the original disk is probably
damaged. You may be able to repair the disk or recover some of the
information on it. If the icon of the second disk does not appear either,
take the disk drive to an Apple-authorized service provider for repair.
m Restart the computer, holding the Shift key down until you see the message
“Extensions off.” If this solves the problem, remove any control panels or
extensions you recently installed.
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A high-density (1.4 MB) disk you use with your PowerBook computer is not recognized
by another Macintosh.

m Some disk drives cannot recognize high-density disks. Try inserting an
800K or 400K disk in the disk drive of the other Macintosh. If that works,
copy your files to an 800K disk or a 400K disk. If you regularly plan to use
floppy disk drives of different types, use the lower-capacity disks in all
drives.
You can’t eject a disk from a floppy disk drive.

m There may be a temporary mechanical problem with the disk drive. Restart
the computer and hold down one of the trackball buttons while the
computer starts up. If that doesn’t work, carefully insert the end of a
straightened paper clip into the small hole near the disk drive’s opening
and push gently until the disk is ejected.
A message says that a disk is not initialized—but you know that it is.

m The disk may not be seated properly in the disk drive. Eject it and try
inserting it again.
m The disk may be damaged. If you insert another disk in the drive and the
message does not appear, you can assume that the original disk needs
repair. If the second disk is also not recognized, call Apple (see the service
and support information for the phone number), or take the disk drive to an
Apple-authorized service provider.
You can’t delete a file.

m The floppy disk may be locked. Unlock it by sliding the tab so that it
covers the hole at the corner of the disk.
m The file may be locked. You can unlock it in its Info window (choose Get
Info from the File menu). Or you can hold down the Option key while you
choose Empty Trash from the Special menu.
m An application program may be using the file. Quit the program.
You can’t save or copy files onto a floppy disk.

m The disk may be locked. Unlock it by sliding the tab so that it covers the
hole at the corner of the disk.
m The disk may be full. Delete files you no longer need or use a different
disk.
See the Macintosh Reference book for more information about working with
disk drives and disks.
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Modems
The external modem doesn’t work.

m The modem may be turned off or improperly connected. Make sure it is
turned on and that all connections are correct.
m The modem port may not be activated. Open the PowerBook Setup control
panel and make sure that Normal is selected.
The internal modem doesn’t work.

m The modem connection may not be activated. Open the PowerBook Setup
control panel and make sure that Compatible is selected.
See the modem manual for more information about using your modem.

Printers
Your computer can’t find the printer.

m The printer may be turned off. Turn it on.
m The printer may not be selected in the Chooser. Open the Chooser and
select the printer you want to use.
Your printer does not appear in the Chooser window.

m The printer may not be connected properly. Check the connections
between your computer and the printer, including relevant sections of the
network if appropriate.
m The printer software may not be in your System Folder. Close the Chooser
and install the software you need.
m AppleTalk must be active before you can use a network printer. Make sure
that AppleTalk is active in the Chooser.
m If your network has zones, the printer you want may not be in the currently
selected zone. Make sure the correct zone is selected.
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The network printer keeps restarting.

m Someone on the network may be using a version of printer software that is
different from the version used by others on the network. Everyone
connected to a network should use the same printer software version.
Consult the network administrator for more information.
Nothing happens, or you see an error message, when you try to print.

m The printer may not be selected in the Chooser. Open the Chooser and
reselect the printer.
m The printer may not be turned on. Make sure it is plugged in, turned on
and warmed up.
m The printer may be out of paper or have some other problem. Check the
printer status lights and any messages on your screen.
m If an error message states that the printer could not print your document,
turn the printer off for at least 10 seconds. Then turn it on again, wait for it
to warm up, and try to print again.
Your documents are printed with the wrong fonts.

m The printer may not have your fonts in its memory and may be substituting
other fonts. You may be able to add the necessary fonts to your printer (see
the Macintosh Reference book for instructions), or print on a different
printer that has the fonts you want. If you have a LaserWriter printer, you
can turn off Font Substitution in the Page Setup dialog box.
See the Macintosh Reference book for general information about printing
documents. See your printer manual for more information about your
printer’s features or problems with the printed output.
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Networks
You can’t find or can’t open icons needed to set up file sharing.

m One or more icons may be in the wrong place. Make sure that the Sharing
Setup icon is in the Control Panels folder, and that the File Sharing
Extension file, the Network Extension file, and the AppleShare file are in
the Extensions folder. (Both folders are inside the System Folder.)
m Some network software may not be installed. Use the Installer to custom
install the appropriate network software. See Appendix A for help using
the Installer.
The shared disk you want to connect to does not appear in the Chooser window.

m AppleTalk must be active before you can use a shared disk. Make sure that
AppleTalk is active in the Chooser.
m If your network has zones, the shared disk you want may not be in the
currently selected zone. Make sure the correct zone is selected.
m The computer that the disk is on must be turned on before the disk can be
shared. Make sure that computer is on and that it has file sharing turned
on.
You can’t open a shared disk or folder.

m You may not have the access privileges needed to use the disk or folder.
Ask the network administrator or the owner of the shared item to give you
access.
m You may have entered your name or password incorrectly when you tried to
open the shared disk or folder. Check with the owner of the item to make
sure you are entering your name and password correctly, and try again.
You can’t connect to your own computer from another Macintosh.

m Make sure that your computer is turned on, file sharing is turned on for
both computers, you have the correct access privileges, and you entered
your name and password correctly.
See the Macintosh Reference book for general information about using your
computer on a network.
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Application programs
A program won’t open.

m Some programs can’t be opened from a locked floppy disk. Make sure the
disk is unlocked. (Unlock a disk by sliding the tab so that it covers the hole
at the corner of the disk.)
m The program may be damaged. Recopy it from a known good source (such
as the original program disk).
m There may not be enough memory available to open the program. Quit
other programs or change this program’s memory size in the Info window.
A program runs very slowly.

m Some programs are slowed by processor cycling. You can turn processor
cycling off; see Chapter 6.
A message says that a program could not be found.

m You may be trying to open a document created with a program you don’t
have on your computer, or created with a different version of the program.
Obtain the correct program and version. Or, open the document with
another program that can read its format. (If another program can open a
document, the program icon becomes highlighted when you drag the
document icon on top of it.)
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A program doesn’t work, or malfunctions consistently.

m You may have more than one copy of the program on your hard disk.
Remove extra copies by dragging them to the Trash.
m The program may be damaged. Recopy it from a known good source (such
as the original program disk).
m Your version of the program may be incompatible with your system
software. Consult the software manufacturer to find out which version of
the program you should be using.
m The program may be using less memory than it needs to work with your
documents. Choose Get Info from the File menu and increase the memory
size.
m You may have added a control panel or extension that is incompatible with
other programs you use. Restart the computer, holding the Shift key down,
until you see the message “Extensions off.” If this solves the problem,
remove any control panels or extensions you recently installed.
You just did something you didn’t mean to do.

m If you have not yet taken any other action, you can usually undo your most
recent action (even if you aren’t sure what it was). Most programs have an
Undo command in the Edit menu. Choose Undo to go back one step in
your work. In most programs, you cannot undo more than one action.
See the documentation that came with your programs for more information
about their operation and features.
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Refer to this chapter when you
need to install or reinstall the
system software on your
PowerBook Duo.

Appendix A
Installing System Software

System software is the set of programs and other files that your computer uses
to start itself up, keep track of your files, and run the application programs
you use. When you turn on your computer, it looks for a disk that contains the
system software. System software is always in a folder called the System
Folder.
Any disk that contains a correct version of system software is a startup disk.
The startup disk is usually the hard disk that’s inside your computer, though
another hard disk or a floppy disk can also be a startup disk.
If your computer cannot find a startup disk, it displays this icon in the middle
of the screen:

If you see that icon, you may need to install or reinstall system software on
your computer’s internal hard disk. You can also attach your computer to an
external hard disk that contains the system software.
If your hard disk already has system software on it and you see that icon: Your
hard disk or system software may be damaged, or there may be problems with
SCSI devices attached to your computer. (See Chapter 9 for more information
on SCSI devices.) You may need to reinstall the system software. See the
section on reinstalling system software later in this appendix for instructions.
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Before you begin
You use the Installer program (which is found on the Install Me First disk) to
install, reinstall, or update system software on a startup disk. When you use
the Installer, you keep any special files you have installed in your System
Folder.
IMPORTANT Before you install a new version of system software, make a

backup copy of your current System Folder on another disk in case you need
it later (to use a program that is incompatible with the new system software,
for example).
To install, reinstall, or update system software, you need
m an initialized hard disk (If you have a hard disk that hasn’t been
initialized—that is, its icon doesn’t even appear on the desktop—go to the
Macintosh Reference book for information on initializing a hard disk.)
m access to system software (system software disks that came with your
computer or access to system software over a network)

Installing system software for the first time
If you have a new hard disk or a newly initialized hard disk that does not
contain system software, follow the steps in this section to do what is
commonly called a “normal” installation of system software.
If you have access to the system software on a network, open the Installer
program on the network and then follow the steps in this section, beginning
with step 11.
If you have a PowerBook Duo Floppy Adapter attached to your PowerBook,
follow all the steps.
1

Shut down your computer.

2

Insert the Disk Tools disk into the floppy disk drive.

3

Turn on your computer.

The Disk Tools icon appears on your computer’s screen.
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4

Double-click the Disk First Aid icon.

Follow the instructions on the screen. Disk First Aid checks your hard drive
for any problems.
5

When Disk First Aid has finished checking your hard drive, choose Quit from the File
menu.

6

Double-click the Apple HD SC Setup icon and follow the instructions on the screen.

7

When you are finished, choose Quit from the File Menu.

8

Shut down your computer.

9

Insert the Install Me First Disk into the floppy disk drive.

10

Turn on your computer.

The Installer program opens automatically.
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11

Click OK.

The Easy Install dialog box appears.

Parts of system
software to be
installed

Click to install the
software you need.

Disk on which system
software will be
installed

Click to install on
a different disk.
Click to install
customized software.

12

Make sure that the hard disk named in the box is the one that you want to install system
software on.

If it isn’t, click the Switch Disk button until the correct disk name appears.
13

Click Install.

14

Follow the instructions that appear on the screen.

If you are installing from floppy disks, you see messages asking you to insert
different disks.
15

When you see a message reporting that the installation was successful, click Restart.

If a message reports that installation was not successful, try installing again.
(Follow the instructions on the screen.)
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Reinstalling system software
If your system software is damaged, you need to reinstall system software.
These steps outline what is commonly called a “clean” installation of system
software.
1

Shut down your computer.

2

Insert the Disk Tools disk into the floppy disk drive.

3

Turn on your computer.

The Disk Tools icon appears on your computer’s screen.
4

Double-click the Disk First Aid icon.

Follow the instructions on the screen. Disk First Aid checks your hard drive
for any problems.
5

When you are finished, choose Quit from the File Menu.

6

Double-click the Apple HD SC Setup icon and follow the instructions on the screen.

7

Click Update.

8

When you are finished, choose Quit from the File menu.
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9

Check to make sure that at least 5 MB of space is available on the hard disk where you
want to reinstall the system software.

Open your hard drive and choose by Icon from the View Menu. The amount
of space available on the hard disk appears in the upper-right corner of the
window. If there is less than 5 MB of disk space available, delete unnecessary
files until you have at least 5 MB of disk space available.
10

Create a new folder named “Old Finder.”

11

Open the System Folder and drag the file called “Finder” to the Old Finder folder.

12

Rename the System Folder “Storage.”

13

Shut down your computer.

14

Turn on your computer.

The blinking question mark icon should appear.
If you don’t see the blinking question mark: If your computer starts up, you
have another System Folder on your hard disk. Find it (you can use the Find
command in the File menu), and go back to step 10.
15

Insert the Install Me First Disk into the floppy disk drive.

The Installer program opens automatically.
16

Click OK.

The Easy Install dialog box appears.

Parts of system
software to be
installed
Disk on which system
software will be
installed

Click to install the
software you need.

Click to install on
a different disk.
Click to install
customized software.
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17

Make sure that the hard disk named in the box is the one you want to install system
software on.

If it isn’t, click the Switch Disk button until the correct disk name appears.
18

Click Install.

19

Follow the instructions that appear on the screen.

20

When you see a message reporting that the installation was successful, click Restart.

If a message reports that installation was not successful, try installing again.
(Follow the instructions on the screen.)
After you are finished reinstalling the system software, make sure that your
computer starts up without any problems. Once you know that the new
software fixed any problems you were having before, you can copy any
special software (control panels, extensions, custom utilities) back to your
System Folder from the folder you renamed “Storage.”
IMPORTANT Be very careful not to replace any of the files in the System

Folder with files from the Storage folder.

Installing customized system software
Custom installation allows you to select just the files you want. You can use
custom installation to install or update a single file or to save space on your
hard disk by installing only the files you need.
1

Shut down your computer.

2

Insert the Install Me First disk into the floppy disk drive.

3

Turn on your computer.

The Installer program opens automatically.
4

Click OK.

The Easy Install dialog box appears.
5

Make sure that the hard disk named in the box is the one you want to install system
software on.

If it isn’t, click the Switch Disk button until the correct disk name appears.
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6

Click the Customize button.

The custom installation dialog box appears. All available components of the
system software are listed.
7

Scroll through the list of items and hold down the Shift key as you click the items you
want to install.

If you want to conserve space on your hard disk, select the “minimal
software” option for your computer.

8

Click Install.

9

Follow the instructions that appear on the screen.

10

When you see a message reporting that the installation was successful, click Restart.

If a message reports that installation was not successful, try installing again.
(Follow the instructions on the screen.)
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Refer to this chapter when you want
to use the PowerBook File Assistant
that came with your computer
to synchronize files.

Appendix B
Using the PowerBook File Assistant

The PowerBook File Assistant is software that synchronizes files on your
PowerBook and desktop Macintosh by automatically updating files whenever
you make changes. With File Assistant, you can always be sure that the file
you are working on is the current version.

What is file synchronization?
If you use two Macintosh computers, you may often have the same file or
folder on both computers. But you may have a problem keeping track of what
files are on what computer.
With the PowerBook File Assistant you can make sure you always have the
most recent version of a file or folder on both computers. The process of
updating the files on both computers is called file synchronization. With the
PowerBook File Assistant, you can synchronize individual files or folders.
Before you can use the PowerBook File Assistant to synchronize files, you
need to connect your PowerBook to another Macintosh. For instructions, see
“Using Your PowerBook as a SCSI Disk” in Chapter 9 of this manual, or
Chapter 7, “Using Your Computer on a Network,” in the Macintosh Reference
manual.
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Starting the PowerBook File Assistant
Once you have installed the PowerBook File Assistant, you are ready to
decide which files you want to synchronize.
m Double-click the PowerBook File Assistant icon.

The File Assistant Setup window appears:

Linking files or folders for synchronization
Before you can synchronize files or folders, you need to link them. Linking
joins two identical copies of a file or folder together so that when one file or
folder in the pair is modified, the linked file or folder is also changed.
IMPORTANT Files cannot be linked if they are not identical copies, but you can

link folders with different names or contents.
Before linking, make sure that each computer’s clock is set for the same time
and date. See the Macintosh Reference book that came with your computer for
information on how to set the time and date on your computer’s clock.
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To link files or folders, follow these steps:
1

Drag the icon of a file or folder you want to link to a selection box in the File Assistant
Setup window.
The selection box is this area
on either side of the arrow.

Drag the icon of a file or folder you
want to synchronize to a selection box.

2

Drag the matching icon to the other selection box.

Once you have two matching files or folders in the Setup window, you have a
linked pair. Another pair of selection boxes appears. Repeat steps 1 and 2 to
link more pairs of files or folders.
The setup screen grows as you add to the list of linked pairs. Use the scroll
bars on the right of the screen to see parts of the list that are not in view.
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Setting the direction of the link
Notice the arrow between the two linked files; this is how you can tell the
direction in which the files are linked. Normally the PowerBook File
Assistant synchronizes files in both directions, but you can set the direction to
be one way, from either left to right or right to left.
A one-way link is helpful if you want to receive updated versions of a
document from a file server on a network.
1

Click the pair of linked files to select it.

Click the item selection box for either file or folder in the pair.
2

Choose the direction you want from the Synchronize menu.

Choose two-way
synchronization to
update either file when
the corresponding file
in the pair changes.
Choose one-way synchronization to update a
file on your hard disk from a network server.

The direction of the arrow between the two linked files in the Setup window
changes to reflect your choice.
The arrow changes to indicate the direction of the link.
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Linking non-matching folders
PowerBook File Assistant lets you link folders that have different names and
contain different files.
1

Choose Preferences from the File Menu.

The following dialog box appears:

Click here to be able
to link folders with
different names.

2

Click the checkbox to allow non-matching folder names.

3

Click OK.

Now you can link folders that have different names and contents. The first
time you synchronize a pair of non-matching folders, PowerBook File
Assistant copies all the files from one folder to the other, so that the folders
have identical contents.
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Deleting a linked pair
If you don’t want to synchronize a linked pair anymore, you can delete the
linked pair from the Setup window.
1

Click the pair you want to delete to select it.

To select more than one pair, hold down the Shift key and click other pairs.
To select all pairs, choose Select All from the Edit menu.
2

Choose Delete Pairs from the Edit menu.

The pairs you selected are deleted from the Setup window.
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Synchronizing linked folders or files
To synchronize files or folders you linked in the Setup window, you must do
two things:
m Connect the disks containing the files you are synchronizing.
m Open the PowerBook File Assistant.
Now you are ready to synchronize the linked files or folders. Any time you
make a change to either item, the same change is made to the linked item. If
an item is deleted, you’ll be asked to confirm that you want to delete the
corresponding file or folder.
Information about each linked pair is displayed in the Setup window.

The name of the disk
appears here.

If the files have been
synchronized, the time
and date appear here.

You can set PowerBook File Assistant to synchronize files either manually or
automatically. You choose which you want when you link the items.
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Manual synchronization
When you choose manual synchronization, you decide when you want to
update a linked pair.
1

Select a pair, then choose Manual from the Synchronize menu.

2

Click the arrow in the File Assistant Setup window.
Click the arrow to synchronize the pair.

A message appears telling you that the files are being updated.
You can also manually update files that are linked by selecting the pair and
then choosing Synchronize Now from the Synchronize menu.

Automatic synchronization
To update linked files automatically whenever a change is made to either of
the linked files:
m Select the pair and then choose Automatic from the Synchronize menu.
A message appears whenever files are being updated. You can also set
pairs to be updated every time you connect with another disk. See “Setting
Up Completely Automatic Synchronization” later in this Appendix.
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Understanding the alert messages
As you synchronize linked pairs, the PowerBook File Assistant displays alert
messages about the synchronization. You can turn off the alert messages by
following these steps:
1

Choose Preferences from the File menu.

A dialog box appears.
2

Click the “Warn when can’t synchronize” checkbox to deselect it.

The messages do not appear.
If you don’t want the alert message to appear when a file or folder is put in
the Trash, click the checkbox next to “Warn before deleting” to deselect it. Be
very careful if you turn off the alert message that warns you when files are
put in the Trash. Items are put in the Trash during synchronization whenever
a linked item is deleted or renamed.
3

Click OK.

Alert messages are turned off. If you want to turn them back on, choose
Preferences from the File menu and click the checkboxes again to reselect
them.
To turn alert messages off temporarily, hold down the Option key. While you
hold down the Option key, the alert messages for any commands you execute
are turned off.
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Setting up completely automatic synchronization
The PowerBook File Assistant needs to be running in order to synchronize
your files. To set up your system to automatically synchronize linked files:
1

Select the pair and then choose Automatic from the Synchronize menu.

2

Use the AutoRemounter control panel to reconnect to shared disks.

See Chapter 7 for instructions on automatically reconnecting to
(“remounting”) shared disks.
3

Drag an alias of the PowerBook File Assistant icon to the Startup Items folder.

The Startup Items folder is in your PowerBook’s System Folder.
See the Macintosh Reference book for help on creating an alias.

Now whenever AutoRemounter “mounts” your disks and the PowerBook File
Assistant is open, all automatically linked pairs are synchronized.
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Refer to this appendix for
information on using the Macintosh
PC Exchange program that came
with your computer

Appendix C
Exchanging Files With DOS or Windows

Macintosh PC Exchange is software included with your computer that lets
you easily exchange documents between your Macintosh and a DOS or
Windows computer. You can use Macintosh PC Exchange to create floppy
disks compatible with DOS computers.

Macintosh PC Exchange at a glance
You can open, edit, and save DOS documents using
your favorite Macintosh application programs.
Using the
PC Exchange control
panel, you can specify
which Macintosh
programs are used to
open DOS documents.

You can use and create
DOS-format disks.

For example, DOS
documents whose
names end with
this suffix . . .
. . . are to be opened
by this program . . .
. . . as this type of document.
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Using DOS-format disks on your Macintosh
The format of a disk refers to the way the computer prepares the disk to
receive information. Macintosh computers and DOS computers use different
disk formats, but with Macintosh PC Exchange installed in your Macintosh
system, your Macintosh can read disks of either format.
To use a DOS-format disk on your Macintosh, simply insert the disk into your
computer’s floppy disk drive. The disk’s icon appears on the desktop. You can
open the disk by double-clicking its icon—the same way you would open an
ordinary Macintosh disk.

When you insert a DOS-format
floppy disk, you see this icon.

If you see a message that the disk is unreadable, see Chapter 10 of this book.
WARNING Do not attempt to repair a DOS-format disk using disk repair

utility programs intended for use on the Macintosh. Doing so is likely to
destroy any information on the disk. If you must repair a DOS-format
floppy disk, use a disk repair utility on your DOS computer.

146

Appendix C

Creating a blank DOS-format disk
When you erase or initialize a disk on the Macintosh, you can choose its
format—either Macintosh or DOS.
WARNING Before you erase or initialize a disk, be sure that the disk

contains no information you want to save.
To create a blank DOS-format disk on your Macintosh, follow these steps:
1

Insert a floppy disk.

m If the disk has not been initialized, a dialog box appears in which you can
specify the disk’s name and format.

m If the disk has already been used, you’ll need to erase it. Select the disk,
then choose Erase Disk from the Special menu.
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A dialog box appears in which you can specify the disk’s name and format.

2

Type a name for the disk.

3

Choose the disk format you want from the Format pop-up menu.

The list of available formats varies depending on your disk drive and the
capacity of the disk. Choose DOS if you plan to use the disk on both
Macintosh and DOS computers.

4

Click Erase (or Initialize).

If you’re initializing a disk, an alert box appears. Click the Continue button.
The Macintosh prepares the disk in the format you chose.
Usually it takes less than a minute to initialize or erase a floppy disk.
However, if portions of the disk have been damaged, the initialization process
may take several minutes.
If you changed the disk’s format the disk’s icon will change when you
re-insert the disk.
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Opening DOS documents on your Macintosh
Opening a document from within a Macintosh program
The surest way to open a DOS document on the Macintosh is to use the Open
command from within an application program.
1

Open the program you want to use.

2

Choose Open from the File menu.

A directory dialog box appears.

Many programs have buttons or pop-up
menus that let you open or import
documents of a particular file format.

3

Select the document you want, and click Open.

If you have problems opening the document, see Chapter 10 of this book.

Opening a document by double-clicking its icon
Before you can open a DOS document by double-clicking its icon, you need
to use the PC Exchange control panel to specify which Macintosh application
programs will open DOS documents, as described next.
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Assigning Macintosh programs to DOS documents
Using the PC Exchange control panel, you can assign Macintosh application
programs to DOS documents. For example, you can specify that all DOS
documents whose filenames end with the suffix .XLS are to be opened in the
Macintosh program Microsoft Excel.
The figure below shows the PC Exchange control panel with some
assignments already created.

DOS documents
whose names end
with this suffix…

…are to be opened
by this Macintosh
program…
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…as this type
of document.

Before you can assign a Macintosh program to a group of DOS documents,
there are three questions you need to answer:
m What suffix do the documents have in common?

Many DOS programs automatically add a three-letter suffix (or filename
extension) to a document’s name. For example, these PageMaker documents
all share the suffix .PM4:
NEWS.PM4
REPORT.PM4
RESUME.PM4
m What Macintosh application program do you want to use to open the documents?

Each Macintosh document has a creator—that is, the Macintosh program
used to create the document. When you double-click a document’s icon,
the Macintosh opens the program that created the document.
Using the PC Exchange control panel, you can assign Macintosh programs
to DOS documents as “creators.”
m What type of document is it?

Most programs are able to open or import some, but not all, types of
documents. A document’s type is a three- or four-letter code (such as TEXT
or PICT) that tells a program whether or not it can recognize the
document. A program displays documents of types it can recognize in its
directory dialog box.
Unless you specify otherwise, the Macintosh assumes that all DOS
documents have the document type TEXT. You can assign different types
to some DOS documents. See the next section.
A document’s type is different from its file format, which refers to the way
information within the document is encoded. If a program is unable to
accurately interpret a document’s file format, the document’s formatting may
be displayed incorrectly. (To find out which file formats a program can
understand, refer to the documentation for the program.)
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Recommended assignments for some widely used application
programs
The information in this section will help you assign documents from some
widely used DOS/Windows programs to some widely used Macintosh
programs. (For more information, see the documentation for your application
programs.)
AMI Pro (Windows), version 2.0
Documents in AMI Pro (Windows) version 2.0 are automatically saved with
the suffix .SAM.
To open these documents on the Macintosh, add one of the following
assignments to the PC Exchange control panel:
DOS Suffix

Macintosh application

Document type

.SAM

MacWrite® II (version 1.1)

TEXT

.SAM

Microsoft Word (version 5.0)

TEXT

.SAM

WordPerfect (version 2.0)

TEXT

.SAM

WriteNow (version 2.2)

TEXT

Lotus 1-2-3 (Windows), version 1.0
Documents in Lotus 1-2-3 (Windows) version 1.0 are automatically saved with
the suffix .WK3.
To open these Lotus 1-2-3 documents on the Macintosh, add one of the
following assignments to the PC Exchange control panel:
DOS Suffix
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Macintosh application

Document type

.WK3

Lotus 1-2-3 (version 1.0)

TEXT

.WK3

Microsoft Excel (version 3.0)

TEXT

Microsoft Excel (Windows), version 3.0
Documents in Microsoft Excel (Windows) version 3.0 are automatically saved
with the suffix .XLS.
To open these Microsoft Excel documents on the Macintosh, add one of the
following assignments to the PC Exchange control panel:
DOS Suffix

Macintosh application

Document type

.XLS

Lotus 1-2-3 (version 1.0)

TEXT

.XLS

Microsoft Excel (version 3.0)

TEXT

Microsoft Word (Windows), version 2.0
Documents in Microsoft Word (Windows) version 2.0 are automatically saved
with the suffix .DOC.
To open these documents in Microsoft Word (Macintosh) version 5.0, add the
following assignment to the PC Exchange control panel:
DOS Suffix
.DOC

Macintosh application

Document type

Microsoft Word (version 5.0)

WDBN

PageMaker (Windows), version 4.0
Documents in PageMaker (Windows) version 4.0 are automatically saved with
the suffix .PM4.
To open these documents in PageMaker (Macintosh) version 4.0, add the
following assignment to the PC Exchange control panel:
DOS Suffix
.PM4

Macintosh application
PageMaker (version 4.0)

Document type
ALB4
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Quattro (DOS), version 3.0
When saving documents in Quattro (DOS) version 3.0 be sure to save them
with the suffix .WK1 (rather than the default suffix, .WQ1). Quattro saves
documents ending in .WK1 in the Lotus 1-2-3 file format, which can be
interpreted by many Macintosh spreadsheet programs.
To open these Quattro documents on the Macintosh, add one of the following
assignments to the PC Exchange control panel:
DOS Suffix

Macintosh application

Document type

.WK1

Claris Resolve™ (version 3.0)

.WK1

Lotus 1-2-3 (version 1.0)

TEXT

.WK1

Microsoft Excel (version 3.0)

TEXT

Ventura Publisher (Windows), version 3.2
Documents in Ventura Publisher (Windows) version 3.2 are automatically
saved with the suffix .CHP.
To open these documents in Ventura Publisher (Macintosh) version 3.2 add
the following assignment to the PC Exchange control panel:
DOS Suffix
.CHP

Macintosh application
Ventura Publisher (version 3.2)

Document type
VCHP

WordPerfect (DOS) version 5.1
WordPerfect (DOS) version 5.1 does not automatically add a suffix to the
names of documents. The easiest way to open WordPerfect (DOS) documents
on the Macintosh is by choosing the Open command from within an
application program.
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Adding an assignment to the PC Exchange control panel
To add an assignment, follow these steps:
1

Choose Control Panels from the Apple (K) menu.

The Control Panels folder opens.
2

Open the PC Exchange control panel.

Double-click the PC Exchange icon, or select the icon and choose Open from
the File menu.

The PC Exchange control panel appears.
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3

Click the Add button.

A dialog box appears in which you can specify a DOS suffix and its
corresponding Macintosh application program and document type.

4

Type a three-letter DOS suffix in the DOS Suffix box.

To specify which Macintosh program will open DOS documents with no
suffix, click inside the box to set the insertion point, but leave it blank.
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5

Select a Macintosh application program from the directory section of the dialog box.

6

Choose a document type from the Document Type pop-up menu.

Document types are indicated by icons and four-letter codes whose meanings
are seldom obvious. For help choosing the correct document type, see the
information in the previous section, “Recommended Assignments for Some
Widely Used Application Programs.”
If you don’t know which document type to choose, try TEXT.
7

Once you’ve specified a DOS suffix, a Macintosh application program, and the
appropriate document type, click OK.

The assignment is added to the list in the control panel.
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Trying out an assignment
To try out an assignment you’ve added to the PC Exchange control panel,
follow these steps:
1

Insert a DOS-format floppy disk and open its icon.

PC Exchange assignments take effect when you insert a floppy disk, or when
you open a DOS-format floppy disk. (If the disk window was already open,
you need to close it and open it again.)
2

Double-click the icon of a DOS document whose filename ends with the suffix you
specified.

The document is opened by the appropriate Macintosh application program.
(You might see a message that the document’s file format is being converted.)
If you have problems opening documents, see Chapter 10 of this book.

Editing the list of assignments
You can change, remove, and sort assignments in the PC Exchange control
panel.

To sort the list of
assignments, click
a category.

To change an
assignment, select
it in the list, then
click Change.
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To remove an assignment, select
it in the list, then click Remove.

Sharing assignment lists with other users
The list of assignments is stored in the PC Exchange Preferences file. This
file is stored in the Preferences folder inside the System Folder.

You can make sure that every licensed user of Macintosh PC Exchange in
your office uses the same assignments. Make copies of the PC Exchange
Preferences file and place one copy in the Preferences folder (inside the
System Folder) of each licensed user’s Macintosh.
Do not change the name of the PC Exchange Preferences file.

Saving documents onto a DOS-format disk
You save documents onto a DOS-format disk the same way you save them
onto a Macintosh disk––by choosing the Save command from the File menu.
IMPORTANT Be sure to leave at least 5K of extra disk space when you save or

copy files onto a DOS-format floppy disk. (The Macintosh needs this space to
store Macintosh-specific information about files on the disk, such as the
location of icons and windows on the Macintosh desktop.)
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Choosing a file format
In some programs you’ll have the choice of saving the document in one of
several file formats.

The Save As dialog
box may include
buttons or pop-up
menus for choosing
a file format.

A document’s file format refers to the way information within the document is
encoded. If a program cannot accurately interpret a document’s file format, it
may display the document incorrectly (as in the figure below).

When you save a document that you plan to use with another program, be
sure to save it in a file format that the other program can understand. (To find
out what file formats a program is able to open, import, and save, see the
documentation you received with the program.)

Naming files for use on both Macintosh and DOS computers
On DOS computers, filenames are limited to eight characters (plus a threeletter suffix) and may not contain spaces. The rules for naming Macintosh
files are less restrictive. Therefore, when working on the Macintosh, it’s
possible to give a file a name that would be “illegal” on DOS computers.
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For example, suppose you created a file on your Macintosh named
July Budget.DOC
If you viewed the same file on a DOS computer, its name would be
!JULYBUD.DOC
The exclamation mark (!) indicates that the name has been shortened.
A file can thus have two names: a long name (for when the file is displayed
on the Macintosh) and a short name (for when it’s displayed on a DOS
computer).
While using a DOS-format floppy disk on the Macintosh, you can see a
document’s short name by selecting the document, choosing the Get Info
command from the File menu, and clicking the document’s name in the Info
dialog box. (For this procedure to work, you must have the File Sharing
Extension installed.)
Long name

Short name

Viewing the contents of a disk on your DOS computer
When you view the directory of a disk on your DOS computer, you might
notice additional directories named RESOURCE.FRK. These directories
contain important information, known as resources, which are contained in
some Macintosh documents.
WARNING Do not delete or move any directories named

RESOURCE.FRK, and do not move any files out of these directories.
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reinstallation 131
Apple HD SC Setup icon 129

Apple menu
Battery 60
Control Panels
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processor speed feature 75
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automatic sleep and 72, 113
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application programs
assigning to DOS documents
150–159
opening DOS documents from 149
troubleshooting 125–126
arrow keys, selecting items with 40
arrow pointer, moving with trackball 10
automatic file or folder synchronization
142, 144
automatic sleep 8, 61
Battery Conservation settings and
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problems with 113, 120
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in File Assistant 144

B
backup battery 67
backup System Folder 128
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Dock II 91
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carpal tunnel syndrome 45
chaining SCSI devices 99–104
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.CHP files (Ventura Publisher) 154
cleaning the computer 42, 43
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close box 20
on Control Strip 49, 50
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closing the Control Strip 50
closing a document 36
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choosing from pull-down menus 40
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contrast controls 5
control panels, Control Strip vs. 50
Control Panels (Apple menu)
AutoRemounter options 78
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for external modem setup 95
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Mouse control panel 85
for PC Exchange assignments 155
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processor speed feature 75
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for setup as SCSI disk 105
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control panels vs. 50
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hiding 51
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Sound Volume module 49, 57
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copying disk contents 38
problems with 121

copying icons 33
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Undo command for 126
creating a new document 21–24
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44–45
cursor. See pointer
custom installation dialog box, for system
software 134
customizing 77–86
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Battery Conservation settings 73–76
Control Strip 52
for delayed printing 86
improving pointer display 85
RAM disk 79–84
system software 133–134

D
Delete key, for typing errors 22
Delete Pairs (Edit menu), in File
Assistant 140
deleting disk contents 39, 121.
See also Trash
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hiding Control Strip on 51
organizing 39
desktop Macintosh, synchronizing
PowerBook files with 135–144
dialog boxes, selecting items in 40
dimmed commands 40
directories, viewing on DOS
computer 161
directory dialog boxes, keyboard
shortcuts 40
Disk First Aid, for system software
installation 129
reinstallation 131
Disk First Aid icon 129
disks, opening higher-level 35. See also
floppy disks; hard disk
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disk space, for system software 132
Disk Tools disk
Battery Reconditioning program
on 67
installing system software from
128–129
restarting computer from 110
display. See monitor, external; screen
display
.DOC files (Microsoft Word for
Windows) 153
docking a PowerBook Duo 89–92
documents. See also files
choosing folders for 37
creating 21–24
creators of 151
DOS
assigning Macintosh programs to
150–159
filename extensions and 151
opening 149
saving documents onto DOSformat disks 159–161
naming 22–23, 37
for DOS format 160–161
opening and closing 36
opening from within programs 36
RESOURCE.FRK directories and 161
saving and naming 22–23, 37
on DOS-format disks 159–161
storing inside folders 25–26
types of 151, 157
working with 36–37
DOS, exchanging files with 145–161.
See also Windows programs;
specific programs
DOS documents
assigning Macintosh programs to
150–159
filename extensions 151
opening 149
saving Macintosh documents as
159–161
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160–161
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computer 161
WordPerfect files 154
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automatic sleep and 72, 113
processor cycling and 74
SCSI disk mode and 104
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troubleshooting 117
Duo Floppy Adapter 38, 93
Duo MiniDock 92
automatic sleep and 113
troubleshooting 118

E
Easy Install dialog box
for reinstallation 132
for system software 130
Edit menu, Undo 126
Edit menu (File Assistant), Delete Pairs
140
ejecting a disk 38
problems with 121
electromagnetic emissions 48
Empty Trash (Special menu) 28
entering text, in blank document 22
Enter key, selecting items with 40
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Erase Disk (Special menu) 39

erasing disk contents. See also Trash 39
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eye fatigue prevention 45
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44–45
error correction
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Undo command for 126
error messages, restarting computer after.
See also troubleshooting 8
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Dock II 90
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F
fatigue, avoiding 45, 48
File Assistant 135–144
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starting 136
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141–144
File Assistant Setup window 136, 137
File menu
New Folder 25, 39
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for DOS document 149
Quit 24
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Save 22–23, 37
for saving to DOS-format disk 159

Save As 37
for choosing a DOS format 160
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160–161
files. See also documents
linked
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synchronizing 141–142
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File Sharing, on Control Strip 49, 56
File Sharing Setup control panel 56
file synchronization, defined 135
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keyboard shortcuts in 40
selecting items in 40
in system software reinstallation 132
Finder menu bar 29
flickering screen 114
floppy disk drive
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on Duo Dock/Duo Dock II 90
problems with 120, 121
floppy disk drive port
on Duo Floppy Adapter 93
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floppy disks
copying 38
DOS-format
creating 147–148
saving documents onto 159–161
using 146
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erasing contents of 39
problems with 120, 121
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unlocking 125
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folders
choosing for document 37
creating new 39
linked
deleting 140
synchronizing 141–142
linking in File Assistant 136–139
opening 26
opening higher-level 35
placing icons inside 39
storing work inside 25–26, 37
font problems 123
footrest 46

G
ghost images 114
grounding plug 2

H
hard disk
copying to floppy disk from 38
copying from floppy disk to 38
Disk First Aid check of 129
installing system software on
128–134
problems with 110, 120
removing an item from 34
saving a new document to 22–23
sleep mode and 72
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using PowerBook as 104–107
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ports for 90, 92
sound input port warning 97
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Help menu 40
Show Balloons, for Control Strip 49
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reinstallation 111, 131–133
Install Me First disk, Installer program
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K
keyboard
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L
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deleting linked pairs 140
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M
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review questions 15–20
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See DOS, exchanging files with
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cleaning the computer 42, 43
cleaning the trackball 116
service and support 88
manual file or folder synchronization
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adding to computer 97
insufficient 116
application problems and 125, 126
RAM disk requirement 79
virtual 97
power conservation and 70
unavailable 116
Memory control panel 80
power conservation and 70
setting up RAM disk with 79–80,
81–82
menus, pull-down, working with 40
microphone, connecting 97
microprocessor, power conservation by
74–75
Microsoft Excel for Windows,
exchanging files with 153
Microsoft Word for Windows,
exchanging files with 153

MiniDock 92
automatic sleep and 113
troubleshooting 118
modem
power conservation and 71
troubleshooting 122
modem, external
connecting to Duo system 94–95
problems with 122
modem port
on Duo Dock/Duo Dock II 90
on Duo MiniDock 92
Modem port icon 94
modules, in Control Strip 49
rearranging 52
monitor, external. See also screen display
adjusting for comfort 48
Duo Dock/Duo Dock II and 90, 91
Duo MiniDock problems 118
electromagnetic emissions from 48
MiniDock and 92
PowerBook Display control panel
for 98
using for presentations 98
Video Mirroring module for 58, 98
monitor port, on Duo Dock/Duo
Dock II 90
mouse
positioning for 47
setting for tracking 85
Mouse control panel 85
moving the computer, warnings about 42
moving the Control Strip 52
moving icons 33
moving windows 27
musculoskeletal discomfort 44–45
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N

P

naming a document 22–23, 37
for Macintosh or DOS use 160–161
naming a folder 25
naming icons 33
network
automatic sleep and 72
AutoRemounter feature 78
connecting printer on 96
delaying printing on 86
installing system software from
128, 130
troubleshooting 124
printer problems 122–123
new document
creating 21–24
saving and naming 22–23, 37
new folder, creating 39
New Folder (File menu) 25, 39
new folder icon 25
NuBus card slots, on Duo Dock/Duo
Dock II 90

PageMaker (Windows), exchanging files
with 153
password, shared disk reconnection
and 78
PC Exchange 145. See also DOS,
exchanging files with
PC Exchange control panel 155
PC Exchange Preferences file 159
plug adapters 87
plugging in the PowerBook Duo 1–2
.PM4 files (PageMaker) 153
pointer
adjusting tracking speed of 114
frozen 115
improving display of 85
moving with trackball 10
ports, connecting cables or adapters
to 42
power adapter 1–2, 42
battery icon and 53
for battery recharger 63
RAM disk and 84
recharge indicator 60
recharging the computer with 62
travel adapters for 87
power adapter port 2
PowerBook control panel. See Control
Panels (Apple menu)
PowerBook Duo 230
processor speed feature 75
reconditioning battery in 70
PowerBook Duo 280
reconditioning battery in 67–69
sleep mode indicator on 72
PowerBook Duo 280c
reconditioning battery in 67–69
sleep mode indicator on 8, 55, 72

O
Open (File menu) 26, 36
for DOS document 149
opening the Control Strip 50
opening the display 3
opening a document 36
from within a program 36
opening a folder 26
opening icons 33
organizing the desktop 39
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Index

PowerBook Duo systems 89–93. See
also specific systems
adding memory to 97
adding SCSI devices to 99–104
connecting a modem to 94–95
connecting a printer to 96
connecting sound input/output devices
to 97
Duo Dock/Duo Dock II 89–91
Floppy Adapter 93
MiniDock 92
using for presentations 98
PowerBook File Assistant 135–144
alert messages in 143
deleting linked files or folders in 140
linking files or folders in 136–139
starting 136
synchronizing linked files or folders in
141–142
PowerBook File Assistant icon 136
PowerBook HD icon 12
PowerBook Setup control panel
for external modem 95
for SCSI disk setup 105
power button 5
losing unsaved work with 7
power conservation settings, changing
54, 76
power management 59–76. See also
batteries; battery power
Control Strip for 49, 54
low-power messages 61
maximizing work time 70–76
SCSI disk mode and 107
troubleshooting 112–113
Power On key 4
no response from 5
Power Settings, on Control Strip 49, 54
changing 54, 76
power sources 59
conservation settings and 76
practice session 21–30

Preferences (File menu), in File Assistant
for linking files or folders with
different names 139
for turning off alert messages 143
printer
connecting 96
troubleshooting 122–123
Printer/modem port icon 94
printer port 96
on Duo Dock/Duo Dock II 90
on Duo MiniDock 92
Printer port icon 96
printing, deferring until later 86
processor cycling 74–75
programs slowed by 125
processor speed feature 75
program, checking where you are 29
pull-down menus, working with 40

Q
Quattro, exchanging files with 154
question mark icon, system software
warning 6, 127
quick reference information 31–40
Quit (File menu) 24
for starting over 30
quitting a program 24
quitting SCSI disk mode 108
quiz on basics 15–18

R
radio and television interference, vii
RAM, adding to computer 97
RAM cache function, on Duo Dock/Duo
Dock II 91
RAM contents
backup battery and 67
low power and 61
system sleep and 72
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RAM disk
persistent 79
for power conservation 70
Restart command and 8
setting up 79–83
shutting down and 80
as startup disk 81–83
using 84
recharging the battery 42, 43, 62–65
problems with 112–113
reconditioning the battery 67–69
recycling batteries 66
reinstalling system software 111,
131–133
removing items from disk 34
removing or replacing batteries
65–66, 67
repetitive stress injuries (RSIs) 44–45
repositioning. See entries beginning with
moving
resizing the Control Strip 51
RESOURCE.FRK directories 161
Restart button 8
restarting the computer 8, 30
problems with 110–111
for temporary “crash” 111
Restart (Special menu) 8, 30
Return key, selecting items with 40
review of basics 15–18
RSIs (repetitive stress injuries) 44–45

S
safety considerations 41–43
battery leakage 66
children and 41
grounding plug 2
.SAM documents (AMI Pro) 152
Save (File menu) 22–23, 37
for saving to DOS-format disk 159
Save As (File menu) 37
for choosing a DOS format 160
saving and naming documents 22–23, 37
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disk problems 121
screen display. See also monitor, external
adjusting for comfort 3, 47
brightness and contrast controls 5
cleaning 43, 48
closing, for sleep mode 7
electromagnetic emissions from 48
lifting and adjusting 3
low-power messages and 61
organizing desktop 39
power conservation and 70, 71, 72
problems with 114–115
startup 4
scroll arrows 20
on Control Strip 49
scroll bar 20
scrolling through a window 34
SCSI devices 99–108
battery power and 107
connecting 99–104
defined 99
disconnecting PowerBook from 108
terminators for 102
troubleshooting 119
using PowerBook as 104–107
SCSI disk mode
battery power and 107
quitting 108
using PowerBook in 104–107
SCSI drivers, installing 100
SCSI hard disk drive, on Duo Dock/Duo
Dock II 90
SCSI icon 106
SCSI ID numbers, setting 100–101
SCSI port 99
on Duo Dock/Duo Dock II 90
on Duo MiniDock 92
SCSI port icon 99
selected icons, commands and 30
selecting icons 32
selecting items, keyboard shortcuts
for 40
serial port
automatic sleep and 72

connecting printer to 96
service and support 88
setting up the PowerBook Duo 1–6
setting up your work area 45
shared disk
automatic reconnection to 78
automatic sleep and 72
automatic synchronization on 144
problems with 124
Show Balloons (Help menu), for Control
Strip 49
Shut Down (Special menu) 7
RAM disk and 80
for storing the computer 88
SimpleText icon 21
SimpleText program
opening 21
quitting 24
size box 20
Sleep (Special menu) 7
sleep mode
automatic 8, 61
Battery Conservation settings and
72–73
problems with 113, 120
AutoRemounter feature and 78
entering 7–8, 56, 60
from Battery desk accessory 60
from Control Strip 55–56
moving the computer in 42
problems with 113
RAM disk and 84
recharging battery in 65
shutting down from 7
waking up from 8, 56
Sleep Now, on Control Strip 49, 55
Small Computer System Interface (SCSI)
99. See also entries beginning
with SCSI
software. See also application programs;
system software
incompatibility problems 112
installing SCSI drivers 100
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sound input/output
connecting devices for 97
on Duo Dock/Duo Dock II 90
on Duo MiniDock 92
Sound Volume, on Control Strip 49, 57
speakers
connecting 97
ports for 90, 92
Special menu
Empty Trash 28
Erase Disk 39
Restart 8, 30
Shut Down 7
RAM disk and 80
for storing the computer 88
Sleep 7
spills, warning about 42
starting over 30
starting up
problems 5–6, 110, 120
setting up RAM disk for 81–83
turning on the computer 4
startup disk, defined 127
Storage folder, System Folder and 133
storing documents in folders 25–26
storing the PowerBook 88
stress, avoiding 44–48
summary of basics 31–40
support sources 88
Synchronize menu 138
synchronizing files or folders 141–142
linking for 136–139
system error, restarting computer after 8
System Folder
backing up 128
copying to RAM disk 81
more than one, problems from 111
PC Exchange Preferences file in 159
Storage folder and 133
system sleep. See sleep mode
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system software
battery problems and 113
defined 127
installing
customized version 133–134
for the first time 128–130
as reinstallation 111, 131–133
in multiple folders 111
requirement for 6, 127

T
tab, on Control Strip 49, 50, 51
Tab key, selecting items with 40
telecommunications, internal vs. external
modem for 95
television interference, vii
terminators, SCSI 102
text, entering in blank document 22
throwing items away. See Trash
title bar 20
token ring NuBus card, on Duo
Dock/Duo Dock II 90
tour, Macintosh Basics 10–14
trackball
double-clicking 11
problems with 116
settings 85
using 10
tracking speed, adjusting 114
transporting the computer
environmental concerns 42
travel tips 87
Trash
retrieving items from 34
role of 20
throwing items into 27–28
Trash icon 27
traveling with the PowerBook 87

troubleshooting 109–126
application programs 125–126
computer stops working 111
disk drives and disks 120–121
Duo Dock/Duo Dock II 117
Duo MiniDock 118
memory problems 116
modem problems 122
network problems 122–123, 124
odd behavior 111–112
power problems 112–113
printer problems 122–123
restart problems 110–111
screen problems 114–115
SCSI devices 119
starting over 30
startup problems 5–6, 110, 120
trackball problems 116
viruses 112
warranty concerns 42, 109
turning on the PowerBook Duo 4
problems with 5–6
turning off the PowerBook Duo 7
tutorial 9–30
Macintosh Basics tour 10–14
practice session 21–30
review questions 15–20
typing, avoiding pain from 46, 47
typing text 22

U
Undo command (Edit menu) 126
untitled folder icon 25
upgrading memory 97

V
Ventura Publisher, exchanging files
with 154
Video Mirroring module 49, 58
video mirroring, turning on or off
with Control Strip 58
with PowerBook Display control
panel 98
video support, on Duo Dock/Duo
Dock II 91
viewing window contents 34, 35
virtual memory 97
power conservation and 70
unavailable 116
viruses 112
VRAM, on Duo Dock/Duo Dock II 91

W
waking the computer 8, 56
wall mount plug 2
warranty concerns 42, 109
windows
active 20, 30, 35
disappearing 115
moving 27
opening 34
viewing contents of 34, 35
working with 34–35
Windows programs, exchanging files
with 145–161
AMI Pro 152
Lotus 1-2-3 152
Microsoft Excel 153
Microsoft Word 153
PageMaker 153
Ventura Publisher 154
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The Apple Publishing System
This Apple manual was written, edited, and produced on a desktop publishing system using
Apple Macintosh computers and QuarkXPress. Technical illustrations were drawn in Adobe™
Illustrator; screen shots were created and modified with system software, Exposure Pro, Aldus
SuperPaint, and Adobe Photoshop. Proof pages were created on Apple LaserWriter printers and
on QMS and Tektronix color printers. Final pages were output directly to separated film on a
PostScript™-driven imagesetter.
Text type is Times®, display type is Helvetica® Narrow, and cover type is Apple Garamond,
Apple’s corporate font. Ornaments are custom symbols designed for Apple Computer.
PostScript, the LaserWriter page-description language, was developed by Adobe Systems
Incorporated.

